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1.  Java program to find out the given number is even or odd 

Aim: Write a java program to find out the given number is even or odd. 

Description : A Number divisible by 2, if the reminder will be ‘Zero’ (0) then the number is even or the given number is odd. i.e. N%2= 
= 0 it is called even number other wise if N%2 != 0 is called odd. 

 
Program: 
 
Class even odd 
{ 
Public static void main (String args []) 
{ 
int n= Integer.parseInt (args[0]); 
if (n%2 == 0) 
{ 
System.out.println (“The given number is even no.“); 
else 
System.out.println (“The given number is odd no.“); 
} 
} 
} 
 
 
 
*out put: >javac even odd.java 
>java even odd 67 
              The given number is odd 
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2.  Java program to find the (given number is) big number in given 3 numbers. Using nested if statement. 

 
Aim: program to find the (given number is) big number in given 3 numbers. Using nested if statement. 

Description: To input 3 numbers and compare each number with other number by using the nested if statement. First compare the first 

two numbers and find the biggest number, then biggest number will compare with the third number, and then print the biggest value. 
Program: 
Import java.io.*; 
Class biggest  
{ 
Public static void main (String args[]) 
{ 
int a= Integer.parseInt (args[0]); 
int b= Integer.parseInt (args[1]); 
int c= Integer.parseInt (args[2]); 
if (a>b)  
{ 
if (a>c) 
{ 
System.out.println (“The biggest value is a =”+a); 
} 
else 
{  
System.out.println (“The biggest value is c =”+c); 
} 
} 
else 
{ 
if (b>c) 
{ 
System.out.println (“The biggest value is b =”+b); 

} 

} 

 

*out put: >javac biggest.java 
>java biggest 45 30 41 
              The biggest value is 45 
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} 
else 
{ 
System.out.println (“The biggest value is c =”+c); 
} 
} 
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3.  Java program to find a day name by entering a number using switch condition 

Aim: program to find a day name by entering a number using switch condition 

Description: To keep a number from the user and generate an integer between 1 to 7 and display of the week day. As 1 for Sunday 2 for 

Monday, 3 for Tuesday, 4 for Wednesday, 5 for Thursday, 6 for Friday, 7 for Saturday. Any other number will be display as wrong. 

Program: 

Class day name 
{ 
Public static void main (String args []) 
{ 
int n= Integer.parseInt (args [0]); 
Switch (n) 
{ 
Case 1: System.out.println (“The day name is Sunday”); 
Break; 
Case 2: System.out.println (“The day name is Monday”); 
Break; 
Case 3: System.out.println (“The day name is Tuesday”); 
Break; 
Case 4: System.out.println (“The day name is Wednesday”); 
Break; 
Case 5: System.out.println (“The day name is Thursday”); 
Break; 
Case 6: System.out.println (“The day name is Friday”); 
Break; 
Case 7: System.out.println (“The day name is Saturday”); 
Break; 
Default: System.out.println (“The given day name is wrong”); 
} 
} 
} 
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*out put :> javac dayname.java 
>java day name 8 
             The given day name is wrong 
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4.  Java program to calculate sum of two numbers using Buffered Reader class. 

Aim: Write a java program to calculate sum of two numbers using Buffered Reader class. 

Description: Read two numbers input string buffering two numbers so as to provide for efficient reading of two numbers. The buffer 

size may be used or default size may be used. Each read request made of a Reader causes a corresponding read request to be made of 

byte stream. It is therefore advisable to wrap a buffer reader around any reader whose read () operator may be costly such as File 

Reader around any reader whose read operations may be costly. Buffer Reader (System. in) create a buffering character input system 

that uses a difficult size in different buffer. 

Program: 
Import java.io.*; 
Class total 
{ 
Public static void main (String args []) throws Io Exception 
{ 
Buffered Reader br= new Buffered Reader (new InputStreamReader (System. in)); 
System.out.println (“Enter a first value :”); 
int a= Integer.parseInt(br.readline ()); 
System.out.println (“Enter a second value :”); 
int b= Integer.parseInt (br.readline ()); 
int c = a+b; 
System.out.println (“The sum is:”+c); 
} 
} 
 
 *out put: >javac total.java 
>java total 
               Enter a first value: 600 
               Enter s second value: 400 
               The sum is: 1000 
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5.  Java program to print 1 to 10 natural numbers using for loop. 

Aim: java program to print 1 to 10 natural numbers using for loop. 

 
Description: Input upper limited to 10 find sum of natural numbers. Store it as “N” initialized, another variable to store sum of 
numbers say sum = 0. In other to find sum we need to iterate through all between 1 to 10. Initialize a loop from 1 to 10 and increment 

loop counter by 1 each iteration. The loop print the value of sum, I ++. Inside the loop add previous value of sum with i. which is sum = 

sum + I. finally after loop print the value of sum. 

 

Program: 
 
Class numbers 
{ 
Public static void main (String args []) 
{ 
System.out.println (“The Natural numbers from 1 to 10:”); 
for (int a=1; a<=10; ++a) 
{ 
System.out.println (a); 
} 
} 
} 
 
*out put: >javac numbers.java 
>java numbers 
              The natural numbers from 1 to 10: 
                 1 
                 2 
                 3 
                 4 
                 5 



 

13 
 

                 6 
                 7 
                 8 
                 9 
               10 
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6.  Java program to calculate factorial value for a given number. 

Aim: // program to calculate factorial value for a given number. 

Description: The factorial of a given number using “For” statement. The function of a positive integer N is equal to 1 x 2 x 3 x 4 … N 
you will learn to calculate the factorial of a given value. (Factorial = Factorial * (N-1)) 

 
Program: 
 
Class factorial  
{ 
Public static void main (String args []) 
{ 
Scanner sc = new Scanner (System. in); 
System.out.println (“Enter a value :”); 
int n = sc.nextInt (); 
int f=1; 
for (int a=1; a<=n; ++a) 
{ 
f=f*a; 
} 
System.out.println (“\n The factorial value is:”+f); 
} 
} 
 
 
 
 
*out put: >javac factorial 
>java factorial 
              Enter a value: 10 
              The factorial value is: 3628800 



 

15 
 

7.  Java program to find out of the Reverse number 

Aim: //program to find out of the Reverse number  

Description: To input 4 digits integer number, the number divisible by 10 the remainder will be treated as reverse number, the reverse 

number multiplied by 10 and adds the previous reverse number. And then given number is divided by 10, the quotient value will be new 

value of given number. The loop will be continued upto given number will be reached to the zero. Then it prints the reverse number. 

Program: 
 
import java.util.*; 
Class reverse 
{ 
Public static void main (String args []) 
{ 
Scanner sc = new Scanner (System. in); 
System.out.println (“Enter a value :”); 
int n = sc.nextInt (); 
int d, r=0; 
While (n! =0) 
{ 
d=n%10; 
r=r*10+d; 
n= n/10; 
} 
System.out.println (“The Reverse number is:”+r); 
} 
} 
 
*out put: >javac reverse.java 
>java reverse 
               Enter a value: 5674 
               The Reverse number is: 4765 
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8.  Java program to find out the given number is Armstrong (or) Not 

Aim: // program to find out the given number is Armstrong (or) Not 

Description: An Armstrong number of three digits, the sum of cubes of each digit is equal to the number it self is called Armstrong 

Number. For ex : 153 = 1 X 1 x 1 + 5 X 5 X 5 + 3 X 3 X 3 = 153. 

Program: 
 
import java.util.*; 
Class Armstrong 
{ 
Public static void main (String args []) 
{ 
Scanner in = new Scanner (System. in); 
int n = sc.nextInt (); 
System.out.println (“Enter a value :”); 
int d, s=0; x=n; 
While (n! =0) 
{ 
d=n%10; 
s=s+d*d*d; 
n=n/10; 
} 
if (x ==s) 
System.out.println (“\n The given number is Armstrong :”); 
else 
 System.out.println (“\n The given number is Armstrong :”); 
} 
} 
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*out put: >javac Armstrong.java 
>java Armstrong 
              Enter a value 153 
              The given number is Armstrong 
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9.  Java program to find prime numbers from 2 to N. 

Aim: Write a java program to find prime numbers from 2 to N. 

Description: A prime number can be divide without remainder, only by itself and by one. For Ex : 17 can be divided by 17 and by 1 only. 

The only even prime number = 2. Al other numbers can be divided by 2. To prove whether a number is a prime number, first by try 

dividing it by two and see it  you get a whole number. If you do, it cannot be prime number. If you do not get any whole number, next 

try dividing it by prime numbers 3, 5, 7, 11………………. And so on. 
Program: 
import java.util.*; 
Class primeno1 
{  
Public static void main (String args []) 
{ 
Scanner sc = new Scanner (System. in); 
System.out.println (“\n Enter a value for n :”); 
int n = sc.nextInt (); 
System.out.println (“\n The prime Numbers from 2 to”+n); 
for (int a=2; a<=n; ++a) 
{ 
Boolean flag=true; 
for (int i=2; i<=a/2; ++i) 
{ 
if (a%i==0) 
{ 
flag =false; 
break; 
} 
} 
if (flag==true) 
System.out.println (“a+”\t”); 
} 
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} 
} 
 
*out put :> javac primeno1.java 
>java primeno1 
             Enter a value for n: 20 
            2 3 5 7 11 13 17 19 
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10.  Java program to read and print student data using class. 

Aim: Write a program to read and print student data using class. 

Description : This program defines a class student data members such as name, roll no, age. Define appropriate method to intialise and 

display the value of the data and numbers. Also  print same data of a student. 

 
Program: 
 
import java.util.*; 
Class student 
{ 
In to roll no; 
String name; 
Into age; 
void get data () 
{ 
Scanner sc = new Scanner (System. in); 
System.out.println (“Enter student Roll no, Name and Age:”); 
Roll no = sc.nextInt (); 
Name = sc.nextInt (); 
Age = sc.nextInt (); 
} 
Void put data () 
{ 
System.out.println (“\n student Roll no:”+ roll no); 
System.out.println (“\n student Name:”+ name); 
System.out.println (“\n student Age:”+ age); 
} 
} 
class demo student 
{ 

 

 

 

*out put: >javac demostudent.java 
>java demo student 
              Enter student roll no, name and                  
                 age: 17328 
 
                   Murthy                                                                    
                     17 
 
 
 
               Student roll no: 17328 
                Name: Murthy  
                  Age: 17 
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Public static void main (String args []) 
{ 
Student s = new student (); 
s.getdata (); 
s. put data (); 
} 
} 
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11.  Java program to read & print employee data (e-code, name, designation, salary)using class. 
 

Aim:  write a java program to read & print employee data (e-code, name, designation, salary) using class. 
Description: This program defines a class of employee with four data members such as emp code, name, designation, salary. Define 

appropriate methods to initialize and display the value of the data members. And print the same data of a employee. 

Program: 
Import java.util.*; 
Class employee 
{ 
int code; int salary; 
String name, job; 
void read (int a, string b, string c, int d) 
{ 
Code= a; 
Name= b; 
Job=c; 
Salary= d; 
} 
Void display () 
{ 
System.out.println (“\n employee code:” +code); 
System.out.println (“\n employee name:”+name); 
System.out.println (“\n employee designation:”+job); 
System.out.println (“\n employee salary:”+salary); 
} 
} 
Class demo employee 
{ 
Public static void main (String args []) 
 { 

Scanner sc=new Scanner (System. in); 

e.display (); 
} 
} 
 

 

 

*out put :> javac demoemployee.java 
>Java demo employee 
                Enter employee code, name, job and  
               salary: 328 Murty 
                Civil officer 
               1, 00,000 
               Employee code: 328 
               Name: Murty 
               Designation: civil officer 
               Salary: 1, 00,000 
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System.out.println (“enter employee code, name, job and salary :”); 
Int w=sc.nextInt (); 
String x = sc.nextInt (); 
String y= sc.nextInt (); 
String z=sc.nextInt (); 
employee E =new employee (); 
e.read (w, x, y, z); 
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12.  Java program to find the sum of numbers using overloading. 

Aim: write a java program to find the sum of numbers using overloading. 

Description: Method overloading is a feature that allows a class to have more than one method having the same name. if their argument 

list are different, it is similar to the constructor. Overloading in java, method overloading is a done by declaring same method  with 

different parameters. The parameters must be different in either of these members sequence or types of parameters. In this program a, 

b and c are the numbers the sum of (a + b), (a + b + c) are the class overloading with values. 

 
Program: 
import java. Util. *; 
Class sample 
{ 
int sum (int a, int b) 
{ 
return (a+b); 
} 
int sum (int a, int b, int c) 
{ 
return (a+b+c); 
} 
double sum (double a, double b) 
{ 
return (a+b); 
} 
} 
Class overloading 
{ 
Public static void main (String args []) 
{ 
Sample s = new sample (); 
System.out.println (s. sum (10, 20)); 



 

25 
 

System.out.println (s. sum (100,200,300)); 
System.out.println (s.sum (1.1, 2.2)); 
} 
} 
 
 
*out put :> javac overloading.java 
>java overloading 30 
                                        600 
                                        3.000000        
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13.  Java program using Default Constructor. 

Aim: Write a java program using Default Constructor. 

Description : If you don’t  implement any constructor in our class the java compiler insert default constructor into your code. On your 

behalf, you will not see the default constructor in our source code as it is inserted during the complications and present in the byte code 

(class. file) 

 
Program: 
Class Sample 
{ 
Public sample () 
{ 
System.out.println (“calling constructed method……..”); 
} 
Void show () 
{ 
System.out.println (“calling show method…….”); 
} 
} 
Class constructor 
{ 
Public static void main (Sting args []) 
{ 
System.out.println (“Execution Begins…..”); 
Sample s; 
System.out.println (“Object Declared…..”); 
S= new sample (); 
s. show (); 
 System.out.println (“End of the program….”); 
} 
} 
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*out put: >javac constructor.java 
> Java constructor 
                Execution Begins…… 
               Object Declared…… 
               Calling constructed method  
               Calling show method 
               End of the program 
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14.  Java program to find the Area of the circle using constructor. 

Aim: Write a java program to find the Area of the circle using constructor. 

Description: To calculate or print area of circle in a “Area Method” and the formula in the math is a = pi r x r or a = pi r x r. but if you 

were return like that then the system won’t  understand, until and unless you again the value “pi” is   22/7 as usually you always 
represent the values in binary numbers. 

 
Program: 
Class area  
{ 
Int l, w, a; 
Public area () 
{ 
l=0; 
w=0; 
} 
public area (int x) 
{ 
l=0; 
w=0; 
} 
public area (int x, int y) 
{ 
l=x; 
w=y; 
} 
void show () 
{ 
a=l*w; 
System.out.println (“the Area is: “+a); 
} 
} 

a1.show (); 
a2.show (); 
a3.show (); 
} 
} 
 

 

 

 

*output: > javac parameterised.java 
>java parameterized 
             The Area is: 0 
             The Area is: 100 
             The Area is: 10 
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Class parameterized 
{ 
Public static void main (String args []) 
{ 

area a1= new area (); 
area a2= new area (10); 
area a3=new area (5, 2); 
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15.  Java program on using “this” object. 

Aim: write a java program on using “this” object. 

Description : The key word this is reference a variable in java that refers to the current object the various uses of this key word in java or follows. 
It can be used refers instant variable of a current class. It can be used to invoke or initiate current class constructor. It can be passed as on 
arguments in the method call. It can passed as arguments in the construct call. It can be used to return the current class constant. In this program 
the class sample, the instant variable name and number the method set data to input the value for name and number. The main method where 
we create an object for sample class, and call method input and  output. 
Program: 
 
Class sample 
{ 
int no; 
string name; 
void input (int no, string name) 
{ 
this .no =no; 
this .name=name; 
} 
void output () 
{ 
System.out.println (“No:”+no); 
System.out.println (“Name:”+name); 
} 
} 
Class demo this 
{ 
public static void main (String args []) 
{ 
Sample s=new sample (); 
s. input (101,”Murthy”); 
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s. output (); 
} 
} 
  *output: >javac demothis.java 
>java demos this   
               No: 101 
               Name: Murthy 
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16.  Java program using inheritance. 

Aim: write a java program using inheritance. 

Description: Inheritance enables a derived class to inherit properties and behavior from single parent class. It allows a derived class to inherit the 
properties and behavior of abase class. Thus enabling the code reusability as well as adding new feature to existing code. This makes the code 
much more elegant and less respective. In this program the parent class is person the class student is derived class. The parent class having 
number, name. the derived class having group. Here the student class contents are inherit to person class.  
 
Program: 
 
Import java.util.*; 
Class person  
{ 
int no; 
String name; 
Scanner sc; 
Public person () 
{ 
Sc=new person (); 
} 
Void input () 
{ 
System.out.println (“Enter No and Name :”); 
No =sc.nextInt (); 
Name =sc.nextInt (); 
} 
void output () 
{ 
System.out.println (“No:”+no); 
System.out.println (“Name:”+name); 
} 

void display () 
{ 
System.out.println (“Group:”+group); 
System.out.println (“Age:”+age); 
} 
} 
Class singleinh 
{ 
public static void main (String args []) 
{ 
Student s=new student (); 
s.input (); 
s.read (); 
s.output (); 
s.display (); 
} 

} 
    *Output :> javac singleinh.java 
                  java singleinh 
                  Enter No and Name: 28 
                                               Murthy 
                Enter Group and Age: MCA 
                                               17 
                      No: 28 
                     Name: Murthy 
                     Group: MCA 
                     Age: 17 
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} 
Class students extends person 
{ 
String group; 
int age; 
void read () 
{ 
System.out.println (“Enter group and age :”); 
group =sc.next (); 
age =sc.nextInt (); 
} 
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17.  Java program on Overriding 

 

Aim: //write a java program on Overriding 

 
Description : Declaring a method in a sub class, which is already present in parent class is known as method overloading. Overloading is 

done so that child class can give it own implementation to a method. Which is already provided by parent class. To understand this, we 

have to classes the program, we have to classes a child class boy and parent class human. The boy class extend the human class. Both 

classes have a common method void study()  boy class is given it own implementation to the study() method or in other words it is 

overloading. The study() method overloading is clear here. Child class wants to give to its own implementation so that it calls this 

method “my group is CSE” and print instead of “I am studying intermediate”.  
Program: 
 
import java.util.*; 
Class Human 
{ 
void Study () 
{ 
System.out.println (“I am studying :”); 
} 
} 
Class Boy extends Human 
{ 
void Study () 
{ 
System.out.println (“My group is CSE”); 
} 
} 
Class overriding 
{ 
public static void main (String args []) 
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{ 
Human H=new Human (); 
Boy B=new Boy (); 
H.Study (); 
B.Study (); 
} 
}  
 
 
 
*Output: 
I am studying Intermediate  
My group is CSE 
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18.  Java program on Abstract Class 

Aim: Write a java program on Abstract Class 

Description : A class is declare with in the abstract key word is known as an abstract class as java. In this program bank is an abstract 

class and implementation is provided by a b and demo abstract class. It will be construct SBI() and AB(). 
Program: 
import java.util.*; 
Abstract class bank 
{ 
Abstract int get interest (); 
} 
class SBI extends bank 
{ 
int getinterest () 
{ 
return 6; 
} 
} 
class AB extends bank 
{ 
int getinterest () 
{ 
return 7; 
} 
} 

class demoabstract 
{ 
public static void main (String args []) 
{ 
Bank B; 
B = new SBI (); 
System.out.println (“SBI interest rate:”+B. getinterest ()); 
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B = new AB (); 
System.out.println (“AB interest rate:”+B. get interest ()); 
} 
} 
 
 
*out put :> javac demoabstract.java 
> java demo abstract 
                 SBI interest rate: 6 
                 AB interest rate: 7 
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19.  Java program on Packages 

Aim: Write a java program on Packages 

Description : Here a class sample created inside package name my pack.  To create a class inside a package to declare a package name in the 
first statement of this program. A class can have only one package declaration. Here sample. Java file creates inside a package my pack. 
Program: 
 
 
Package My pack; 
public class sample 
{ 
public void show () 
{ 
System.out.println (“Hello!”); 
} 
} 
import My pack. Sample; 
Class demo pack 
{ 
public static void main (String args []) 
{ 
sample s=new sample (); 
s.show (); 
} 
} 
 
 
 
*output :> javac demopack.java 
>java demo pack 
                Hello! 
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20.  Java program to read N values using Single Dimensional Array. 

Aim: write a java program to read N values using Single Dimensional Array. 

 
Description : This program will be implemented a one dimensional array of N numbers, and print the same.  

Program: 

 
import java.util.*; 
Class narray 
{ 
public static void main (String args []) 
{ 
Scanner sc=new Scanner (System. in); 
System.out.println (“Enter an Array Size :”); 
int n =sc.nextInt (); 
int a [] =new int[n]; 
System.out.println (“Enter “+n+”values :”); 
for (int i=0; i<n; ++i) 
{ 
a [i] =sc.nextInt(); 
} 
System.out.println (“The Array Elements are :”); 
for (int i=0; i<n; ++i) 
{ 
System.out.println (a[i] +”\t”); 
} 
} 
} 
 

*output :> java narray.java 
> java narray 
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               Enter an Array Size: 4 
               Enter 4 values: 2 
                                     5 
                                     6 
                                     7 
           The Array elements are: 2 5 6 7 
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21.  Java program Transpose of Given Matrix. 

Aim: write a java program Transpose of Given Matrix. 

Description : In this program read the one matrices as rows and columns. And print as rows will be converted into columns and 

columns will be converted in to rows. 

Program: 

import java.util.*; 
class Transpose 
{ 
public static void main (String args []); 
{ 
Scanner sc=new Scanner (System. in); 
System.out.println (“Enter matrix size :”); 
int m=sc.nextInt (); 
int n=sc.nextInt (); 
int a [] [] =new int [m][n]; 
System.out.println (“Enter “+m+”x”+n+”matrix”); 
for (int i=0; i<m; ++i) 
{ 
for (int j=0; j<n; ++j) 
{ 
a[i][j] =sc.nextInt (); 
} 
} 
System.out.println (“The original matrix is :”); 
for (int i=0; i<m; ++i) 
 { 
for (int j=0; j<n;++J) 

System.out.println (“The Transpose matrix is :”); 
for (int i=0; i<n; ++i) 
{ 
for (int j=0; j<m;++j) 
{ 
System.out.println (a[i][j]+”\t”); 
} 
System.out.println (); 
} 
} 
} 
output :>javac Transpose.java 
>java Transpose 
               Enter matrix Size: 2 2 
               Enter 2*2 matrix 
                1      2 
                3      4 
               The original matrix is: 
                   1 
                   2 
                   3 
                   4 
               The Transpose of matrix is; 
                  1     3 
                  2     4 
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{ 
System.out.println (a[i] [j] +”\t”); 
} 
System.out.println (); 
} 
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22.  Java program to find out the  (or) Matrix Addition. 

Aim: Write a java program to find out the  (or) Matrix Addition. 

Description : It reads two matrices values and calculate the value of first row and first column of first matrices will added. The first row and first 
column of second matrices. And it will continue so on upto maximum rows and maximum columns using the iteration procedure. The output 
will be displayed the third mercies. 
Program: 
 
import java.util.*; 
Class Matrix add 
{ 
public static void main (String args []) 
{ 
Scanner sc=new Scanner (System. in);  
System.out.println (“Enter first matrix size :”); 
int r1=sc.nextInt (); 
int c1=sc.nextInt (); 
System.out.println (“Enter second matrix size :”); 
int r2=sc.nextInt (); 
int c2=sc.nextInt (); 
if (r1== r2&&c1==c2) 
{ 
int a [][]=new [r1][c1]; 
System.out.println (“Enter first matrix elements :”); 
for (int i=0; i<r1; ++i) 
{ 
for (int j=0; j<C1; ++j) 
{ 
a [i][j]=sc.nextInt (); 
} 
} 

} 
} 
System.out.println (“The Addition matrix is :”); 
for (int i=0; i<r1; ++i) 
{ 
for (int j=0; i<c1; ++j) 
{ 
System.out.println (a[i] [j] =b[i] [j] +”\t”); 
} 
System.out.println (“    ”); 
} 
else 
{ 
System.out.println (“\n The Matrix Addition is not possible”); 
} 
} 
} 

 
 
 
*output :> javac Matrixadd.java 
>Java Matrix add 
               Enter first matrix size: 2 2 
               Enter second matrix size: 2 2 
               Enter first matrix elements: 2 
                                                       4                  2     6 

       6         4     7                                                                                         
                                                       7  
            Enter second matrix elements: 1 
                                                       3                     1    5 
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int b [] []=new int[r2][c2]; 
System.out.println (“Enter second matrix elements :”); 
for (int i=0; i<r2; ++i) 
{ 
for (int j=0; J<c2; ++j) 
{ 
 b [i][j]=sc.nextInt (); 
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23.  Java program to print Matrix Multiplication. 

Aim: // Write a java program to print Matrix Multiplication. 

 
The multiplication of two matrices A[ ] [ ] B [] [] is defined, if the number of columns of A[ ] [ ] is equal to the number of rows  of B[ ] [ ] let A =[aij] be an  
m  X n matrix and B[jk] be an n x p matrix. Then the product of the matrices A and B is the matrix of C order m x p. To get the 
 [ik]th  element of C of matrix C . we take the ith row of A kth column of the B multiply then element wise and take the sum of these product. 
Program: 
import java.util.*; 
Class mul 
{ 
public static void main (String args []) 
{ 
Scanner sc = new Scanner (System. in); 
System.out.println (“Enter first matrix size :”); 
int r1 = sc.nextInt (); 
int c1 = sc.nextInt (); 
System.out.println (“Enter second matrix size :”); 
int r2 = sc.nextInt (); 
int c2 = sc.nextInt (); 
if (c1==r2) 
{ 
int a [] [] = new int [r1][c1]; 
System.out.println (“Enter first matrix elements :”); 
for (int i=0; i<r1; ++i) 
{ 
for (int j=0; j<c1; ++j) 
{ 
a[i][j] = sc.nextInt (); 
} 
} 
int b [][] =  new int [r2][c2]; 
System.out.println (“Enter second matrix elements :”); 
for (int i=0; i<r2; ++i) 
{ 
for (int j=0; j<c2; ++j) 

C[i][j] = 0; 
For(int k=0; k<c1; ++k) 

{ 
C[i][j]=c[i][j]+(a[i][k]*b[k][j]); 

} 

} 
} 

System.out.println(“The matrix multiplication is:”); 
For (int i=0; i<r1;++i) 

{for (int j=0; j<c2; ++j) 
{ 

System.out.println (c[i][j] + “\t”); 
} 
} 

System.out.println (“      “); 
} 

Else 

{ 
System.out.println (“\n the matrix multiplication is not possible:”); 
} 
} 

} 

Output :> javac mul.java 
 >java mul 
Enter first matrix size :2  2 
Enter second matrix size : 2  2 
Enter first matrix elements  
  2   4 
  3   5 
Enter second matrix elements  

1 3 
2    4 

The matrix multiplication is  

  10     22 
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{ 
b [i][j]  = sc.nextInt (); 
} 
} 
int c[][] = new int[r1][c2]; 
for (int i=0; i<r1; ++i) 

{ 
for (int j=0; j<c2; ++j) 
{ 
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24.  Java program to find out given string is PALINDROME (OR) NOT. 

Aim: Write a java program to find out given string is PALINDROME (OR) NOT. 

 
Description : A palindrome is a word phrase, number of sequence of words that records the same back words  as fore words. Punctuation and 
spaces between the words or lettering is allowed. The word palindrome is derived from the Greek plain  or back and dromos or direction the 
most common English palindromes are does that are read character by character for instance   
Level, rotor and racecar, Malayalam, madam.  Madam I am Adam is a famous by character palindrome.     

 

 Program: 
import java.util.*; 
Class palindrome 
{ 
Public static void main (String args []) 
{ 
Scanner sc = new Scanner (System. in); 
System.out.println (“Enter a string :”); 
String a= sc.nextInt (); 
String Buffer sb = new String Buffer (a); 
sb.reverse (); 
String b = sb.toString (); 
if (a. equals (b)) 
System.out.println (“The given string is PALINDROME “); 
else 
System.out.println (“The given string is NOT PALINDROME “); 
} 
} 
*out put: >javac palindrome.java 
>java palindrome 
              Enter a string: Malayalam 
              The given string is PALINDROME 
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25.  Java program multiple Inheritance using Interfaces. 

Aim: Write a java program multiple Inheritance using Interfaces. 
 
Description : Multiple inheritance is a feature of object oriented concept where a class can inheritS properties of more than one parent class. In 
this program class  multi class. Inherits auto, car, bus are sub classes.     
 
Program: 
import java.util.*; 
interface auto 
{ 
int speed = 60; 
void distance (); 
} 
interface car 
{ 
int time = 1; 
void speed (); 
} 
interface bus 
{ 
int distance = 100; 
void time (); 
} 
Class multi implements auto, car, bus 
{ 
public void distance () 
{ 
System.out.println (“The distance is :”+(speed*time)); 
} 
public void speed () 

{ 
Public static void main (String args []) 
{ 
Multi obj = new multi (); 
obj.distance (); 
obj.speed (); 
obj.time (); 
} 
} 
 
 
 
 
*out put: >javac multidemo.java 
>java multidemo 
               The distance is: 60 

               The speed is: 10000 
               The time is: 6000 
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{ 
System.out.println (“The speed is :”+(distance/time*100)); 
} 
Public void time () 
{ 
System.out.println (“The time is :”+(distance*(speed(1))); 
} 
} 
class multidemo 
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26.  Java program on Exception Handling. 

Aim: Write a program on Exception Handling. 
Description : An exception is an unwanted or unexpected event, which occurs during the execution of the program, i.e. run time descript the 
normal flow of the programs instructions.    
 
Program: 
Import java.util.*; 
Class demo exception 
{ 
Public static void main (String args []) 
{ 
Scanner sc = new Scanner (System. in); 
System.out.println (“Enter any two values :”); 
Int a = sc.nextInt (); 
Int b = sc.nextInt (); 
Int c;  
try 
{ 
c=a/b; 
} 
Catch (Arithmetic Exception c) 
{ 
c=0; 
System.out.println (e); 
} 
System.out.println (“\n The Result c=”+c); 
} 
} 
 
 



 

51 
 

 
*out put: >javac demoexception.java 
>java demo exception 
              Enter any two values: 10   0 
              Arithmetic Exception: Zero Divide Error 
              The result c=0 
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27.  Java program on Multithreading. 

Aim: Write a java program on Multithreading. 
Description: Multithreading is a java feature that allows concurrent execution of two or more parents class of a program for maximum utilization 

of cpu.Each part of such program is called thread. So threads are light weight process with in the process. This program created by extending 
the thread class we create. A class that extends java.lang thread class. This class overwrites the run () method available in the thread class.  
 
Program:  
import java.util.*; 
Class sample Extends Thread 
{ 
Public void run () 
{ 
for (int i=1; i<=10; ++i) 
{ 
System.out.println (i); 
Try 
{ 
Thread. Sleep (1000); 
} 
Catch (Interrupted Exception e) 
{ 
} 
} 
} 
} 
Class demo 
{ 
Public static void main (String args []) 
{ 
Sample s1 = new sample (); 

} 
} 
} 
 
*out put: >javac demo.java 
>java demo1        5       9 
                               1        5       9 
                               1        5       9 
                               2        6      10 
                               2        6      10 
                               2        6      10 
                               3        7 
                               3        7 
                               3        7 
                               4        8 
                               4        8 
                               4        8 
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Sample s2 = new sample (); 
Sample s3 = new sample (); 
S1.start (); 
S2.start (); 
S3.start (); 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

54 
 

28.  Java programs to create an applet with some background colour and foreground colour with a message 
 
Aim: Write a java programs to create an applet with some background color and foreground color with a message. 

Description : An applet is a special type of program that is embedded in the web page to generate dynamic content. It runs inside the browser 
and works at claint side. 
 
Program: 
Import java.util.*; 
Import java.awt.*; 
Import java. Applet.*; 
Public class Appl extends Applet 
{ 
String msg = “    “; 
Public void int () 
{ 
Set Background (color. yellow); 
SelForeground (color. red); 
Font f = new Font (“Arial”, Font. BOLD, 20); 
set Font (f); 
msg+=”init”; 
} 
Public void start () 
{ 
Msg + = “start”; 
} 
Public void paint (Graphics g) 
{ 
g.drawstring (msg, 50, 100); 
} 
public void stop () 
{ 

*out put: >javac Appl.java 
<HTML> 
<APPLET CODE =”Appl.class” HEIGHT=300 WIDTH=400> 
</APPLET> 
</HTML> 
 
*out put: >javac Appl.class 
              D :/> applet viewer Appl.html 

Applet viewer: Appl.class   _   X 

Applet 

 
 
 
 

initstart 
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Msg +=”stop”; 
} 
Public void destroy () 
{ 
Msg +=”destroy”; 
} 
} 
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COMPUTER SCIENCE & ENGINEERING 

Second Year (319/71) 

PAPER-I: OOPS & JAVA  

QUESTION BANK 

 
 

SECTION – I             1 X 40 = 40 Marks 

1. Java program to find out the given number is even or odd 
2. Java program to find the (given number is) big number in given 3 numbers. Using nested if statement. 
3. Java program to find a day name by entering a number using switch condition 
4. Java program to calculate sum of two numbers using Buffered Reader class. 
5. Java program to print 1 to 10 natural numbers using for loop. 
6. Java program to calculate factorial value for a given number. 
7. Java program to find out of the Reverse number  
8. Java program to find out the given number is Armstrong (or) Not 
9. Java program to find prime numbers from 2 to N. 
10. Java program to read and print student data using class. 
11. Java program to read & print employee data (e-code, name, designation, salary) using class. 
12. Java program to find the sum of numbers using overloading. 
13. Java program using Default Constructor. 
14. Java program to find the Area of the circle using constructor. 
15. Java program on using “this” object. 
16. Java program using inheritance. 
17. Java program on Overriding 
18. Java program on Abstract Class 
19. Java program on Packages 
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20. Java program to read N values using Single Dimensional Array. 
21. Java program Transpose of Given Matrix. 
22. Java program to find out the  (or) Matrix Addition. 
23. Java program to print Matrix Multiplication. 
24. Java program to find out given string is PALINDROME (OR) NOT. 
25. Java program multiple Inheritance using Interfaces. 
26. Java program on Exception Handling. 
27. Java program on Multithreading. 
28. Java programs to create an applet with some background colour and foreground colour with a message 
 

 

SECTION -II 

Record    - 5 marks 

Viva     –  5 marks 
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COMPUTER SCIENCE AND ENGINEERING 

Second Year (319 / 72) 

PAPER – II : SQL, PHOTOSHOP & FLASH 

INDEX 

 

 S.No.  Name of the Experiment          Page No. 

   

1. DDL Commands              64 

2.  DML Commands              68 
3. Demonstrate different numeric functions with proper syntax and by taking examples.   74 
4. Demonstrate different string and date functions with proper syntax and by taking examples.  79 
5. Write a pl/sql program to check whether given number is Armstrong or not.     86 
6. Write a pl/sql program to print the factorial of a given number.       88 
7. Write a pl/sql program to print the Fibonacci series.        89 
8. Write a pl/sql program to check given string is palindrome or not.      91 
9.  Write a pl/sql program to find sum of n numbers.         93 
10. Write a pl/sql program for addition of two numbers.        94 
11.  Write and demonstrate the purpose of tools in tool box of Photoshop.      95 
12. Demonstrate using or selecting a tool and editing tool preferences in Photoshop.    99 
13. Write and demonstrate the procedure to design a visiting card containing at least one graphic   103 
And text information and prepare a cover page for the book in your subject area using photo shop.  
Plan your own design. 
14. Write and demonstrate the procedure to extract the flower only from given photographic image   106 
and organize it on a background. Selecting your own background for organisation. Adjust the  
Brightness and contrast of the picture so that it gives an elegant look using photo shop. 
15.   Procedure to take a photographic image. Give a title for the image. Put the border. Write your names. 108 
Write the name of institution and place. Apply the effects shadow emboss using Photoshop. 
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16.   Demonstrate the work space of flash.           111 
17.   Demonstrate the procedure to create an animation using flash.       117 
18.   Procedure to create an animation to represent the growing moon.      121 

 
  Question Bank              123 
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EXPERIMENT No. – 1 
DDL COMMANDS 

 

Demonstrate and execute procedure for Create table with the name student with the columns admnno, stdname, phonenumber, grp, 

alter the properties of any two columns, rename the table student to student2019, describe the properties of the table student2019 

and finally drop the table student2019 using DDL COMMANDS in SQL. 

AIM: Demonstrating and execute procedure for Create table with the name student with the columns admnno, stdname, phone 

number, grp, alter the properties of any two columns, rename the table student to student2019, describe the properties of the table 

student2019 and finally drop the table student2019 using DDL COMMANDS in SQL. 

 

DDL COMMANDS: create, alter, drop. 

 

Creating table student: 

 

sql>create table student(admnno number(5),stdname varchar2(20),phone number(5), grp varchar2(10)); 

OUTPUT: Table created. 
 
Describing table student using “Desc” command: 

sql>Desc student; 
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OUTPUT: 

Object Type  TABLE Object  STUDENT 
        

Table Column 
Data 

Type 
Length Precision Scale 

Primary 

Key 
Nullable Default Comment 

STUDENT  ADMNNO  Number - 5 0 - 
 

- - 

  STDNAME Varchar2 20 - - - 
 

- - 

  PHONE Number - 5 0 - 
 

- - 

  GRP  Varchar2 10 - - - 
 

- - 

  
1 – 4 

  
 

 

Altering table properties city and phone: 

sql>alter table student add(city varchar2(20)); 

OUTPUT: Table altered. 

sql> Alter table student modify(phone  number(10)); 

OUTPUT: Table altered. 
 

Describing table student after altering two properties: 
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Object Type  TABLE Object  STUDENT 
        

Table Column 
Data 

Type 
Length Precision Scale 

Primary 

Key 
Nullable Default Comment 

STUDENT  ADMNNO  Number - 5 0 - 
 

- - 

  STDNAME Varchar2 20 - - - 
 

- - 

  PHONE Number - 10 0 - 
 

- - 

  GRP  Varchar2 10 - - - 
 

- - 

  CITY  Varchar2 20 - - - 
 

- - 

  
1 – 5 

  
 

 

Renaming student table to student2019 using “rename” command: 

 

sql: rename student to student2019 

Output: Statement processed. 
 
Describing student table: 

sql: Desc student; 
 
Output: 

Object to be described could not be found. 
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Describing table with the modified name studnet2019: 

sql>desc student2019; 
 
OUTPUT: 

 

Object Type  TABLE Object  STUDENT2019 

Table Column 
Data 

Type 
Length Precision Scale 

Primary 

Key 
Nullable Default Comment 

STUDENT2019  ADMNNO  Number - 5 0 - 
 

- - 

  STDNAME Varchar2 20 - - - 
 

- - 

  PHONE Number - 10 0 - 
 

- - 

  GRP  Varchar2 10 - - - 
 

- - 

  CITY  Varchar2 20 - - - 
 

- - 

  
1 – 5 

  
 

 

Removing table student 2019 from the database. 

sql> drop table student2019; 

 

OUTPUT: Table dropped. 
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EXPERIMENT No. – 2 
DML COMMANDS 

 

CREATE TABLE WITH THE NAME STUDENT, SET ADMNNO AS PRIMARY KEY, INSERT TEN RECORDS, MODIFY THE 

DATA OF TWO STUDENTS, DELETE TWO RECORDS FROM THE TABLE, , AND DISPLAY THE DATA OF THE STUDENT 

TABLE AT EACH STAGE. 

AIM: Creating table with the name student, set admino as primary key, insert ten records, modify the data of two students, delete tworecords 

from the table, and display the data of the student table at each stage. 

CREATING TABLE: 

SQL> create table student(admnno number(5),stdname varchar2(20),grp varchar2(10),phone number(10),address varchar2(10)); 

OUTPUT: Table created. 
sql> desc student 

Table Column Data Type Length Precision Scale Primary Key Nullable Default Comment 

STUDENT  ADMNNO  Number - 5 0 - 
 

- - 

  STDNAME Varchar2 20 - - - 
 

- - 

  GRP  Varchar2 10 - - - 
 

- - 

  PHONE Number - 10 0 - 
 

- - 
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  ADDRESS  Varchar2 10 - - - 
 

- - 

 

INSERTING DATA INTO TABLE: 

sql> INSERT INTO STUDENT VALUES (13635,'CRSASIREKHA','CSE',9999999999,'KOTHAPETA'); 

OUTPUT: 1 row(s) inserted. 

sql>INSERT INTO STUDENT VALUES (13609,'NAGALAKSHMI','BIPC',8888888888,'VANAPALLI'); 

OUTPUT: 1 row(s) inserted. 

sql>INSERT INTO STUDENT VALUES (13525,'JAGADEESWARI','MPC',7777777777,'KAKINADA'); 

OUTPUT: 1 row(s) inserted. 

sql>INSERT INTO STUDENT VALUES (13644,'LAKSHMIDURGA','CSE',6666666666,'KARNOOL'); 

OUTPUT: 1 row(s) inserted. 

sql>INSERT INTO STUDENT VALUES (13725,'DIVAKAR','CEC',5555555555,'AMARAVATHI'); 

OUTPUT: 1 row(s) inserted. 

sql>INSERT INTO STUDENT VALUES (63100,'VENU','CSE',4444444444,'HYDERABAD'); 

OUTPUT: 1 row(s) inserted. 

sql>INSERT INTO STUDENT VALUES (13675,'YAMINI','MPC',3333333333,'VIZAG'); 

OUTPUT: 1 row(s) inserted. 

sql>INSERT INTO STUDENT VALUES (13704,'VARAPRASAD','HEC',2222222222,'KOTHAPETA'); 

OUTPUT: 1 row(s) inserted. 
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sql>INSERT INTO STUDENT VALUES (13712,'GANESH','CSE',1111111111,'VIJAYAWADA'); 

OUTPUT: 1 row(s) inserted. 

sql>INSERT INTO STUDENT VALUES (13735,'DURGA','CSE',0000000000,'KANIPAKAM'); 

OUTPUT: 1 row(s) inserted. 

Displaying data inserted in the table student: 

sql> SELECT * FROM STUDENT; 

OUTPUT: 

ADMNNO STDNAME GRP PHONE ADDRESS 

13635 CRSASIREKHA CSE 9999999999 KOTHAPETA 

13609 NAGALAKSHMI BIPC 8888888888 VANAPALLI 

13525 JAGADEESWARI MPC 7777777777 KAKINADA 

13644 LAKSHMIDURGA CSE 6666666666 KARNOOL 

13735 DIVAKAR CEC 5555555555 AMARAVATHI 

63100 VENU CSE 4444444444 HYDERABAD 

13675 YAMINI MPC 3333333333 VIZAG 

13704 VARAPRASAD HEC 2222222222 KOTHAPETA 
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13712 GANESH CSE 1111111111 VIJAYAWADA 

13735 DURGA CSE 0 KANIPAKAM 

10 rows returned in 0.00 seconds          
 

Updating data in the table student: 

sql> update student set grp='MPC' where admnno=13712; 

output:1 row(s) updated. 

sql> update student set phone=9703406063 where admnno=13725; 

Output: 1 row(s) updated. 

Displaying data of the table student after updating the records: 

sql> SELECT * FROM STUDENT; 

Output: 

ADMNNO STDNAME GRP PHONE ADDRESS 

13635 CRSASIREKHA CSE 9999999999 KOTHAPETA 

13609 NAGALAKSHMI BIPC 8888888888 VANAPALLI 

13525 JAGADEESWARI MPC 7777777777 KAKINADA 

13644 LAKSHMIDURGA CSE 6666666666 KARNOOL 
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13725 DIVAKAR CEC 5555555555 AMARAVATHI 

63100 VENU CSE 4444444444 HYDERABAD 

13675 YAMINI MPC 3333333333 VIZAG 

13704 VARAPRASAD HEC 2222222222 KOTHAPETA 

13712 GANESH MPC 1111111111 VIJAYAWADA 

13735 DURGA CSE 9703406063 KANIPAKAM 

10 rows returned in 0.00 

seconds 

Deleting the records from the table student : 

sql> delete from student where admnno=13635; 

OUTPUT:1 row(s) deleted. 

sql> delete from student where admnno=13644; 

OUTPUT: 1 row(s) deleted. 

Displaying data existed in the student table after deleting two records: 

sql> SELECT * FROM STUDENT; 

OUTPUT: 
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ADMNNO STDNAME GRP PHONE ADDRESS 

13609 NAGALAKSHMI BIPC 8888888888 VANAPALLI 

13525 JAGADEESWARI MPC 7777777777 KAKINADA 

13725 DIVAKAR CEC 5555555555 AMARAVATHI 

63100 VENU CSE 4444444444 HYDERABAD 

13675 YAMINI MPC 3333333333 VIZAG 

13704 VARAPRASAD HEC 2222222222 KOTHAPETA 

13712 GANESH MPC 1111111111 VIJAYAWADA 

13735 DURGA CSE 9703406063 KANIPAKAM 

8 rows returned in 0.00 seconds 
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EXPERIMENT No. – 3 
 

DEMONSTRATE DIFFERENT NUMERIC FUNCTIONS WITH PROPER SYNTAX AND BY TAKING EXAMPLES. 
 

AIM: Demonstrating different numeric functions with proper syntax and by taking examples. 

NUMERIC FUNCTIONS: Numeric functions are used to perform numerical operations on the numbers as per the requirement. Some 

of the Numeric functions are ABS, POWER, ROUND and SQRT. 

ABS: Returns the absolute value of ‘n’. 

Syntax: ABS(n); 

Example: select abs(-25) from dual; 

Output:   

ABS(-25) 

25 

1 rows returned in 0.00 seconds 
   

  

POWER: Returns ‘m’ raised to ‘nth’ power. ‘n’ must be an integer else an error is returned 
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Syntax: POWER(m,n); 

Example: select power(5,2) "raised" from dual; 

 

Raised 

25 

1 rows returned in 0.00 seconds 
 

  

 

ROUND: Return ‘n’, rpimded to ‘m’ places right of the decimal point.  If ‘m’ is omitted, ‘n’ is rounded to 0(zero) places. ‘m’ can be negative to 

round off digits left of the decimal point. ‘m’ must be an integer. 

Syntax: ROUND(n[,m]) 

Example: select round(61.18,1) "Round" from dual; 

Output:  

Round 

61.2 

 

SQRT: Returns square root of ‘n’. If ‘n>0, NULL, SQRT returns a real result. 
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Syntax: SQRT(n) 

Example: select sqrt(144) "Square Root" from dual; 

Output:  

Square Root 

12 

 

ACOS(): It returns the cosine of a number. 

Syntax: SELECT ACOS(0.25); 
Output: 1.318116071652818 

ASIN(): It returns the arc sine of a number. 

Syntax: SELECT ASIN(0.25); 
Output: 0.25268025514207865 

ATAN(): It returns the arc tangent of a number. 

Syntax: SELECT ATAN(2.5); 
Output: 1.1902899496825317 

COS(): It returns the cosine of a number. 

Syntax:SELECT COS(30); 
Output: 0.15425144988758405 

COT(): It returns the cotangent of a number. 
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Syntax: SELECT COT(6); 

Output: -3.436353004180128 

DEGREES(): It converts a radian value into degrees. 

Syntax: SELECT DEGREES(1.5); 

Output: 85.94366926962348 

EXP(): It returns e raised to the power of number. 

Syntax:SELECT EXP(1); 

Output: 2.718281828459045 

FLOOR(): It returns the largest integer value that is less than or equal to a number. 

Syntax:SELECT FLOOR(25.75); 

Output: 25 

LN(): It returns the natural logarithm of a number. 

Syntax:SELECT LN(2); 

Output: 0.6931471805599453 

LOG10(): It returns the base-10 logarithm of a number. 

Syntax:SELECT LOG(2); 

Output: 0.6931471805599453 
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LOG2(): It returns the base-2 logarithm of a number. 

Syntax:SELECT LOG2(6); 

Output: 2.584962500721156 

MOD(): It returns the remainder of n divided by m. 

Syntax:SELECT MOD(18, 4); 

Output: 2 
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EXPERIMENT NO. - 4 
 
DEMONSTRATE DIFFERENT STRING AND DATE FUNCTIONS WITH PROPER SYNTAX AND BY TAKING EXAMPLES. 

 

AIM: Demonstrating different string and date functions with proper syntax and by taking examples. 

STRING FUNCTION 

LOWER: Returns char, with all letters in lower case. 

Syntax: LOWER(char) 

Example: SELECT LOWER('VRSKS SASTRY TANIKELLA') "LOWER" FROM DUAL; 

Output:  

LOWER 

vrsks Sastry Tanikella 

1 rows returned in 0.02 seconds 

INITCAP: Returns string with the first letter in the upper case. 

Syntax: INITCAP(char) 
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Example: SELECT INITCAP('LAKSHMI HASINI TANIKELLA') "Title Case" FROM DUAL; 

Output:  

 

Title Case 

Lakshmi Hasini Tanikella 

1 rows returned in 0.00 

seconds 

UPPERP: Returns char, with all letters forced to upper case. 

Syntax: UPPER (char) 

Example: SELECT UPPER('syamala') from dual; 

Output: 

UPPER('SYAMALA') 

SYAMALA 

1 rows returned in 0.00 seconds 

 

SUBSTR: Returns a portion of char, beginning at character ‘m’ , exceeding upto ‘n’ characters. If ‘n’ is omitted result is returned upto the 

end character.  The first position of character is 1. 

Syntax: SUBSTR(char, m[,n]) 
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Example: SELECT SUBSTR ('JAGADEESWARI',6,7) "SUBSTRING" FROM DUAL; 

Output:  

SUBSTRING 

EESWARI 

1 rows returned in 0.00 

seconds 

 

LENGTH: Returns the length of the char. 

Syntax: LENGTH(char) 

Example: SELECT LENGTH('DHANALAKSHMI') "LENGTH" FROM DUAL; 

Output: 

LENGTH 

12 

 

LTRIM: Removes characters from the left of char with initial characters removed upto the first character not in set. 

Syntax: LTRIM(char[,set]) 

Example: SELECT LTRIM('UPDATE','UP') "AFTER LEFT TRIM" FROM DUAL; 
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Output: 

AFTER LEFT TRIM 

DATE 

 

RTRIM: Returns char with final characters removed after the last character not in the set.  ‘set’ is optional, it defaults to spaces. 

Example: SELECT RTRIM ('HARSHITHA','A') "AFTER RIGHT TRIM" FROM DUAL; 

Output:  

AFTER RIGHT TRIM 

HARSHITH 

1 rows returned in 0.00 seconds 

 

LPAD: Returns ‘char1’, left padded to length ‘n’ with the sequence of characters in ‘char2’ , ‘char2’ defaults to blanks. 

Syntax: LPAD(char1,n,[,char2]) 

Example: SELECT LPAD('PAGE 1', 15,'*')"LPAD" FROM DUAL; 

Output:  

LPAD 

*********PAGE 1 
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1 rows returned in 0.01 seconds 

DATE FUNCTIONS:  

SYSTDATE: To know the current system date. 

Syntax: SYSDATE 

Example: SELECT SYSDATE FROM DUAL; 

OUTPUT:  

SYSDATE 

02-JUN-19 

1 rows returned in 0.02 seconds 

ADD_MONTHS: Returns date after adding the number of months specified with the function. 

Syntax: Add Months(d,n) 

Example: SELECT ADD_MONTHS (SYSDATE, 4) FROM DUAL; 

Output:  

ADD_MONTHS(SYSDATE,4) 

29-SEP-19 

1 rows returned in 0.02 seconds 

 



 

84  

LAST_DAY: Returns the last date of the monthe specified with the function. 

Syntax: LAST_DAY(d) 

Example: SELECT SYSDATE, LAST_DAY (SYSDATE) "LAST" FROM DUAL; 

Output: 

SYSDATE LAST 

29-MAY-19 31-MAY-19 

 

MONTHS_BETWEEN: Returns number of between ‘d1’ and ‘d2’ 

Syntax: MONTHS_BETWEEN(d1,d2) 

Example: SELECT MONTHS_BETWEEN ('11-MAY-2019','11-OCT-2019') FROM DUAL; 

Output:  

MONTHS_BETWEEN('11-MAY-2019','11-OCT-

2019') 

-5 

1 rows returned in 0.00 seconds 

 

NEXT_DAY: Returns next date of the first weekday named by ‘char’ that is after the date named by ‘date. ‘char’,must be a day of the 
week. 
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Syntax: NEXT_DAY(date, char) 

Example: SELECT NEXT_DAY ('29-MAY-2019' , 'WEDNESDAY') "NEXT DAY" FROM DUAL; 

Output:  

NEXT DAY 

05-JUN-19 

1 rows returned in 0.00 seconds 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

86  

 

 

 

 

EXPERIMENT NO. - 5 

1. WRITE A PL/SQL PROGRAM TO CHECK WHETHER GIVEN NUMBER IS ARMSTRONG OR NOT. 

SQL> ed Armstrong 

 declare 

 n number  :=&n; 

 r number; 

 s number := 0; 

 t number; 

 begin 

 t := n; 

 while (n>0) 

 loop 

 r:n mod ; 

output: 

 SQL> @ Armstrong 

 Enter value for n: 121 

 Old 2 : n number := &n; 

 New 2 :n number := 121; 

 Not Armstrong. 

 PL/SQL procedure successfully completed. 
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 s:= s+ r*r*r 

 n:= n/10; 

 end loop; 

 if (t=s) then 

 dbms=output line(‘Armstrong’); 

 else dbms=out.put_line(‘not Armstrong’); 

 end if; 

 end; 
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EXPERIMENT No. – 6 

 

WRITE A PL/SQL PROGRAM TO PRINT THE FACTORIAL OF A GIVEN NUMBER. 

Procedure: 

SQL> ed fact 

 declare 

 i number := 1; 

 f  number := 1; 

 n number :=&n; 

 begin 

 while (i<= n) 

 loop 

 f := f * i;  

 i := i+1; 

 end loop; 

 dbms= output line ‘factorial value is: (f); 

 

Output: 

 

SQL> @ fact 

Input hundred to 1 characters 

Enter value for 2: 5 

Old 4 : n number := &n; 

New 4: number := 5; 

factorial of given number is : 120 

PL/SQL procedure successfully completed. 
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 end; 

 / 

 

 
 

EXPERIMENT No. – 7 

WRITE A PL/SQL PROGRAM TO PRINT THE FIBONACCI SERIES. 
 

Procedure: 

 declare 

  new number; 

 pre number; 

 cur number; 

 N number; 

 

 begin 

  

 n := number; 

Output: 

 

SQL> @ fibo 

Input truncated to 1 Characters 

Enter value for n: 100 

old 7:    n:= &n; 

new 7:   n:=100; 

0 

1 

1 
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 pre := 0; 

 cur := 1; 

 dbms=output.put_line(pre); 

 dbms=output.put_line(cur); 

 new := pre+cur; 

 while(new <= n) 

 loop 

 dbms=output.put_line(new); 

 pre := cur; 

 cur := new; 

 new := pre+cur; 

 end loop; 

 end; 

 

2 

3 

5 

8 

13 

21 

34 

55 

89 

PL / SQL procedure successfully completed. 
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EXPERIMENT NO. - 8 

WRITE A PL/SQL PROGRAM TO CHECK GIVEN STRING IS PALINDROME OR NOT. 
 

PROGRAM: 

 

declare 

  str1  varchar2(20); 

  str2  varchar2(20); 

  l  number; 

  i number; 

  k number; 

  flag number; 

 

Output: 

SQL> @ palin 

Enter value for str1: Malayalam 

Old 9 :    str1 := ‘&str1’; 

New 9 :   str1:= ‘Malayalam’ 

The given string is palindrome 

 

PL/SQL procedure successfully completed. 
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begin 

str1 :=‘&str’; 

str 2 := str1; 

 

l := length(str1); 

k := l; 

flag := 0; 

for i in 1 …….l 

loop 

 if (substr(str1,i,1) != substr(str2,k,1)) 

   then flag := 1; 

 end if; 

 k := k-1; 

end loop; 

if (flag = 0) then 

   dbms=output.put_line(‘The given string is palindrome’); 

else 
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   dbms= output.put_line(‘The given string is not palindrome’); 

end if; 

end; 

 

EXPERIMENT NO. - 9 

WRITE A PL/SQL PROGRAM TO FIND SUM OF N NUMBERS. 
 

SQL> set server output on  

                        SQL> declare 

                        a number (5)=0; 

                        b number (5); 

                        c number (5); 

                        begin 

                        c:=&c; 

                        for b in 1...c loop 

                        a:=a+b; 

                        end loop; 

 OUTPUT: 

 

 

Enter value for c: 12 

old   6: c:=&c; 

new   6: c:=12; 

78 

 

Pl/sql  procedure successfully completed. 
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          dbms_output.put_line(a); 

                       end ; 

           / 

 

 

EXPERIMENT NO. – 10 

WRITE A PL/SQL PROGRAM FOR ADDITION OF TWO NUMBERS 
 

SQL> SET SERVEROUTPUT ON 

Program: 

SQL> declare 

  x  number; 

  y  number; 

  z  number; 

  begin 

  x := 10; 

  y := 35; 

OUTPUT: 

 

45 

 

PL/SQL procedure successfully completed. 
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  z := x+y; 

  dbms_output.put_line(z); 

 end; 

  / 
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EXPERIMENT NO. - 11 

WRITE AND DEMONSTRATE THE PURPOSE OF TOOLS IN TOOL BOX OF  PHOTOSHOP. 

AIM: WRITING AND DEMONSTRATING THE PURPOSE OF TOOLS IN TOOL BOX OF  PHOTOSHOP. 

 

FIG 11.1 
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TOOL BOX IN THE EXPERT MODE 

IN THE EXPERT MODE, THE TOOLBOX IS RICHER THAN THE TOOLBOX IN THE QUICK MODE. THE TOOLS ARE 

ORGANIZED IN THE FOLLOWING LOGICAL GROUPS: 

VIEW TOOLS, SELECT TOOLS, ENHANCE TOOLS, DRAW TOOLS, MODIFY TOOLS, AND COLOUR. 

TOOLS IN THE VIEW GROUP OF THE EXPERT MODE TOOLBOX 

Zoom tool (Z):Zooms in or zooms out your image. The related tools shown in the Tool Options bar are Zoom In and Zoom Out.  
Hand tool (H):Moves your photo in the Photoshop Elements workspace. You can drag your image using this tool. 

TOOLS IN THE SELECT GROUP OF THE EXPERT MODE TOOLBOX 

Move tool (V) : Moves selections or layers. 
Rectangular Marquee tool (M):Selects an area in your image in a rectangular box. Hold the Shift key to make the selection a square. 
Elliptical Marquee tool (M):Selects an area in your image in an elliptical shape. Hold the Shift key to make the selection a circle. 
Lasso tool (L):Selects an area in your image in a free-form shape.  
Magnetic Lasso tool (L):Selects part of an image by selecting the high-contrast edges around a shape. 
Polygonal Lasso tool (L):Draws straight-edged segments of a selection border. 
Quick Selection tool (A):Makes a selection based on color and texture similarity when you click or click-drag the area you want to select.  
Selection Brush tool (A):Selects the area where you paint with the brush. 
Magic Wand tool (A):Selects the pixels with similar colors in a single click. 
Refine Selection Brush tool (A):Adds or removes areas to and from a selection by automatically detecting the edges.  
Auto Selection tool (A):Automatically makes a selection when you draw a shape around the object you want to select.  

TOOLS IN THE ENHANCE GROUP OF THE EXPERT MODE TOOLBOX 

Eye tool (Y):Removes the red eye effect, pet eye effect, and corrects closed eyes in your photos. 
Spot Healing Brush tool (J):Removes spots from your photos.. 
Healing Brush tool (J):Removes spots from your photo by selecting a part of your photo as the reference point. 
Smart Brush tool (F):Applies tonal and color adjustments to specific areas of a photo. 
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Detail Smart Brush tool (F):Paints the adjustment to specific areas of a photo just like a painting tool. 
Clone Stamp tool (S):Paints with an image sample, which you can use to duplicate objects, remove image imperfections, or paint over 
objects in your photo.  
Pattern Stamp tool (S): Paints with a pattern defined from your image, another image, or a preset pattern. 
Blur tool (R):Softens hard edges or areas in an image by reducing details. 
Sharpen tool (R):Sharpens a photo by focusing soft edges in the photo to increase clarity or focus. 
 

Smudge tool (R):Simulates the actions of dragging a finger through wet paint. The tool picks up color where the stroke begins and pushes it 
in the direction you drag.  
Sponge tool (O):Changes the color saturation of an area.  
Dodge tool (O):Lightens areas of an image. You can use the tool to bring out details in shadows. 
Burn tool (O):Darkens areas of the image. You can use the tool to bring out details in highlights. 

TOOLS IN THE DRAW GROUP OF THE EXPERT MODE TOOLBOX 

Brush tool (B) :Creates soft or hard strokes of color. You can use it to simulate airbrush techniques. 
Impressionist Brush tool (B):Changes the existing colors and details in your image so your photo looks like it was painted using stylized 
brush strokes.  
Color Replacement tool (B):Simplifies replacing specific colors in your image. 
Eraser tool (E):Erases the pixels in the image as you drag through them. 
Background Eraser tool (E):Turns color pixels to transparent pixels so that you can easily remove an object from its background.  
Magic Eraser tool (E):Changes all similar pixels when you drag within a photo.  
Paint Bucket tool (K):Fills an area that is similar in color value to the pixels you click.  
Pattern tool (K):Applies a fill or a pattern to your image, instead of using one of the brush tools.  
Gradient tool (G):Fills in an area of image by a gradient. 
Color Picker tool (I):Copies or samples the color of an area in your photo to set a new foreground or background color.  
Custom Shape tool (U):Provides different shape options for you to draw. When you select the Custom Shape tool, you can access these 
shapes in the Tool Options bar.  
 
The other shape-related tools available in the Tool Options bar are: 

 Rectangle 
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 Rounded Rectangle 
 Ellipse 
 Polygon 
 Star 
 Line 
 Selection 

 

Type tool (T): Creates and edits text on your image. 

The other type-related tools available in the Tool Options bar are: 

 Vertical Type  
 Horizontal Type Mask   
 Vertical Type Mask  
 Text on Selection  
 Text on Shape  
 Text on Custom Path 

 

Pencil tool (N):Creates hard-edged freehand lines.  

TOOLS IN THE MODIFY GROUP OF THE EXPERT MODE TOOLBOX 

Crop tool (C):Trims the part of an image according to the selection.  
Cookie Cutter tool (C):Crops a photo into a shape that you choose.  
Perspective Crop tool (C):Transforms the perspective of a picture while cropping it. 
Recompose tool (W):Intelligently resizes photos without changing important visual content, such as people, building, animals, and more. 
Content-Aware Move tool (Q):Selects an object in your photo and moves the selection to a different location, or extends it.  
Straighten tool (P):Realigns an image vertically or horizontally. 
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EXPERIMENT No. 12 

DEMONSTRATE USING OR SELECTING A TOOL AND EDITING A TOOL PREFERENCES IN PHOTOSHOP. 

AIM:  DEMONSTRATING AND USING OR SELECTING A TOOL AND EDITING A TOOL PREFERENCES IN PHOTOSHOP. 

USE A TOOL: 

TO USE A TOOL IN THE QUICK OR EXPERT MODE, FIRST SELECT THE TOOL FROM THE TOOLBOX. NEXT, USE THE 

VARIOUS OPTIONS IN THE TOOL OPTIONS BAR TO ACCOMPLISH YOUR TASK.   

SELECT A TOOL 

Do one of the following: 
 Click a tool in the toolbox. 
 Press the keyboard shortcut for the tool. For example, press B to select the Brush tool. The keyboard shortcut for a tool is displayed in 

the tool tip. 
Note: You cannot deselect a tool—once you select a tool, it remains selected until you select a different tool. For example, if you’ve selected 
the Lasso tool, and you want to click your image without selecting anything, select the Hand tool. 

SELECTING OPTIONS FROM THE TOOL OPTIONS BAR 

The Tool Options bar appears at the bottom in the Photoshop Elements window. It displays the options for a selected tool. For example, if 
you select the Crop tool from the toolbox, you find related tools (Cookie Cutter tool and Perspective Crop tool), and other options in the Tool 
Options bar. 

Note: If the Tool Options bar is not visible, click the tool icon in the toolbox or click Tool Options in the Taskbar.  
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Fig 12.1 

EDIT TOOL PREFERENCES: 

YOU CAN MODIFY THE DEFAULT PREFERENCES FOR TOOLS. FOR EXAMPLE, YOU CAN HIDE THE TOOL TIPS OR 

CHANGE THE APPEARANCE OF A TOOL POINTER. 

 

EDIT GENERAL PREFERENCES 

Step 1: Do one of the following: 

 In Windows, choose Edit > Preferences > General. 
 In Mac, choose Photoshop Elements > Preferences > General. 

Step 2: Set one or more of the following options: 

 Select Show Tool Tips to show tool tips. 
 Select Use Shift Key for Tool Switch to cycle through a set of hidden tools by holding down the Shift key. When this option is 

deselected, you can cycle through a set of tool options by pressing the keyboard shortcut (without holding down Shift). For example, 
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pressing B on your keyboard repeatedly cycles through all the Brush tool options (Brush, Impressionist Brush, and Color 
Replacement tools). 

 Select Select Move tool After Committing Text to select the Move tool after you use the Type tool to add text to your photo. 

STEP 3: CLICK OK. 

SET THE APPEARANCE OF A POINTER 

Step 1: Do one of the following: 
 In Windows, choose Edit > Preferences > Display & Cursors. 
 In Mac, choose Photoshop Elements > Preferences > Display & Cursors. 

Step 2: Select a setting for the painting cursors: 
 Standard Displays pointers as tool icons 
 Precise Displays pointers as cross-hairs 
 Normal Brush Tip Displays pointers as circles at 50% of the size you specify for the brush 
 Full Size Brush Tip Displays pointers as circles at the full size you specify for the brush 
 Show Crosshair In Brush Tip Displays cross-hairs in the circles when you choose either Normal Brush Tip or Full Size Brush 

Tip 
Step 3: Select a setting for other cursors: 
 Standard Displays pointers as tool icons 
 Precise Displays pointers as cross-hairs 

Step 4: Click OK. 

RESIZE OR CHANGE THE HARDNESS OF A PAINTING CURSORS BY DRAGGING ( WINDOWS ONLY) 

You can resize or change the hardness of a painting cursor by dragging in the image. As you drag, you preview both the size and hardness of 

the painting tool. 

 To resize a cursor, right-click + press Alt, and drag to the left or right. 
 To change the hardness of a cursor, right-click + press Alt, and drag up or down. 
  
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RESET TOOL SETTINGS TO DEFAULT: 

YOU CAN RESTORE THE DEFAULT SETTINGS OF A SELECTED TOOL OR ALL TOOLS. 

STEP 1:  SELECT A TOOL FROM THE TOOLBOX. 

ALTERNATIVELY, PRESS KEYBOARD SHORTCUT FOR THE TOOL. . 

Step 2:  Click  to open the pop-up menu in the Tool Options bar and do one of the following: 

 To reset the selected tool, click Reset Tool. 
 To reset all the tools, click Rest All Tools. 

 

 

 

FIG 12.2 
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EXPERIMENT NO. 13 

WRITE AND DEMONTRATE THE PROCEDURE TO DESIGN A VISITING CARD CONTAINING ATLEAST ONE GRAPHIC AND 
TEXT INFORMATION AND PREPARE A COVER PAGE FOR THE BOOK IN YOUR SUBJECT AREA USING PHOTO SHOP. PLAN 
YOUR OWN DESIGN. 

AIM: WRITING PROCEDURE TO DESIGN A VISITING CARD CONTAINING ATLEAST ONE GRAPHIC AND TEXT INFORMATION. 

AND PREPARING A COVER PAGE FOR THE BOOK IN MY SUBJECT AREA.  

PROCEDURE TO DESIGN A VISITING CARD  

Step  1 :  Open adobe Photoshop 7.0->file-> new-> enter height 200 and width 400 for the visiting card. 

Step  2 :  Select the rectangle tool in the tool bar and draw on the half of the work area-> colour it.   

Repeat the same for remaining half-> use different colours to colour. 

Step  3 :  Copy any picture of your choice and place it on the work area-> Resize it using transform tool. 

Step  4:  Select the text tool and type text of your choice. 

Step  5 :  Apply the text font size, colour and style of your choice. 

PROCEDURE TO PREPARE A COVER PAGE FOR THE BOOK IN YOUR SUBJECT AREA. PLAN YOUR OWN DESIGN. 

Step  1 : open adobe Photoshop 7.0->file->new-> enter height 500 and width 400 for the cover page. 

Step  2 : Select the rectangle tool in the tool bar and draw on the half of the work area-> colour it.  

Repeat the same for remaining area-> use different colours to colour. 
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Step  3 : Copy any picture of ur choice and place it on the work area->resize it using free transform tool. 

Step  4 : Select the text tool and type text of your choice. 

Step  5 : Apply the text font size, colour and style of your choice. 

Step  6 : Go to layer->layer style->blended option-> select glow options of your choice. 

Step  7 : Apply the effects using blended options. 

Output: (VISITING CARD) 

 

 

Fig 13.1 
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Output: (COVER PAGE) 

 

FIG 13.2 
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EXPERIMENT NO. 14 

WRITE AND DEMONTRATE THE PROCEDURE TO EXTRACT THE FLOWER ONLY FROM GIVEN PHOTOGRAPHIC IMAGE AND 
ORGANISE IT ON A BACKGROUND. SELECTING YOUR OWN BACKGROUND FOR ORGANISATION. ADJUST THE BRIGHTNESS 
AND CONTRAST OF THE PICTURE SO THAT IT GIVES AN ELEGANT LOOK USING PHOTO SHOP. 

 

Step  1 :  Open adobe Photoshop 7.0 

Step  2 :  File Menu. 

Step  3 :  open from File menu options  

Step  4 : choose a file and open it. 

Step  5 : Select the flower from the image using the lasso tool. 

Step  6 : Go to edit menu.  

Step  7 : select copy option from edit menu options. 

Step  8 : Again go to File Menu 

Step  9 : new option from File menu options. 

Step  10 : Give height 500 and width 500. 

Step  11 : Choose appropriate background and foreground colour from the tool bar. 

Step  12 : Go to edit menu options. 

Step  13 : select fill->under use  

Step  14: select background colour 

Step  15 : select ok. 

Step  16 : Go to edit menu options  
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Step  17 : select paste from edit menu options. 

Step  18 : Select  image menu options. 

Step  19 : Select adjustments otion. 

Step  20 : select Brightness/Contrast. 

Step  21 : After getting the Brightness/Contrast window adjust the brightness and contrast by Dragging the appropriate bar setting. 

Step  22 : Finally save the image file. 

 

OUTPUT:  

   

   

   

   

   

   

 

Fig 14.1 ORIGINAL FLOWER      Fig 14.2 MODIFIED IMAGE 
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EXPERIMENT No. 15 

PROCEDURE TO TAKE A PHOTOGRAPHIC IMAGE. GIVE A TITLE FOR THE IMAGE. PUT THE BORDER. WRITE YOUR NAMES. 
WRITE THE NAME OF INSTITUTION AND PLACE. APPLY THE EFFECTS SHADOW EMBOSS USING PHOTOSHOP. 

 

AIM:PROCEDURE TO TAKE A PHOTOGRAPHIC IMAGE. GIVING A TITLE FOR THE IMAGE and BORDER. WRITE OUR 

NAMES. WRITING THE NAME OF INSTITUTION AND PLACE. APPLY THE EFFECTS SHADOW EMBOSS USING PHOTOSHOP. 

Step 1 : Open adobe Photoshop 7.0 

Step 2 : Select file menu. 

Step 3 : Select new option. 

Step 4 : Enter height 800 and width 600. 

Step 5 : Open an image file and copy the image. 

Step 6: paste the copied image on the new file. 

Step 7 : Right click on the rectangle tool. 

Step 8 : custom shape. 

Step 9 :  select the shape. 

Step 10 : select the colour 

Step 11 : drag on your image. 

Step 12 : Select the text tool. 

Step 13 : type your name, institution name and place. 

Step 14 :Save the file. 

Step 15 : Select the typed text go to layer. 
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Step 16: Select layer style. 

Step 17 : Select blended option. 

Step 18: Tick drop shadow, inner shadow, bevel . 

Step 19: Select emboss->contour->satin->gradient overlay. 

Step 20: If we want to change font colour . 

a) Double click on the “Colour overlay”. 
b) Select colour at “Blend mode”. 
c) Point the colour. 

d) Select “Ok”. 
Step 21: finally save the image. 

OUTPUT 
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Fig 15.1 
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EXPERIMENT NO.16 

DEMONSTRATE THE WORK SPACE OF FLASH. 

AIM: DEMONSTRATING THE WORK SPACE OF FLASH. 

 

Fig 16.1 
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Flash is a development tool that allows you to create animation and interactive experiences.  

 It is an animation and interactive authoring program.  

 Authoring program is a tool to develop multimedia product, it is designed to manage and manipulate individual multimedia elements and 
provide user interaction.  

 
The followings are the important parts of the workspace: 

1) Timeline  2) Stage  3) Panels    4) Tools Panel. 
1. Timeline : 

 The timeline is used to organize and control the movie’s content by specifying when each object appears on the stage.  
 The timeline has separate layers.  

a) Like transparent sheets of content stacked on top of one another. They allow users draw or place images on different layers without 
affecting other items on other layers. There is no limitation to the number of the layers. A well-categorized system of layers allows 
users to manage objects more efficiently.  

b) Adding a layer causes it to be placed on top of the other layers.  

c) Can be re-ordered by dragging up or down. The “Front and Behind” position of the object on the stage is related to sequence of the 
layers.  

 

Fig 16.2 
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Note: When you choose any of the layers, a pen icon will be displayed on the layer.  

 The timeline has a play head.  
a) The play head indicates which frame is playing.  

b) You can manually move the play head by dragging it left or right. Dragging the played also allows you to do a quick check of the movie 
without having to play it.  

 
 

Fig 16.3 

 The timeline is made up of individual units called frames.  
a) Content is displayed in frames as the play head moves over them when the movie plays.  

b) The status bar indicates the current frame the play head is on.  
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2. Stage  

 Contains all objects that are seen by the viewer in the final movie.  
 You can draw objects on, or import objects to the stage.  
 

3. Panels   

 
 Help you view, organize, and change elements or object in a file.  

 The options available on panels control the characteristics of symbols, instances, colors, type, frames, and other elements. You can use 
panels to customize the Flash interface.  

 Panels include Properties Panel, Library Panel, Tools Panel, Actions Panel, Color Panel, Swatches Panel, and etc.  
 

4. Tools Panel 

 
 Contains a set of tools used to draw and edit graphics and text.  

 Divided into four sections: Tools, View, Colors, and Option.  
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Fig 16.4 
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The followings are the tools and their functions: 

Tool Name  Function  
Selection  Selects objects on the work area; an object must be selected before it can be modified.  

Sub selection  Selects objects or parts of objects by dragging a rectangular selection marquee.  
Modifies specific anchor points in a line or curve.  

Free Transform  Moves, scales, rotates, skews, or distorts objects.  

Lasso  Selects objects or parts of objects by dragging a free-form selection marquee.  

Pen  Draws lines or curves by creating a series of dots (anchor points technically) that are automatically connected.  

Text  Creates and edits text.  

Line  Draws straight lines (strokes) of varying lengths, widths and colors.  

Rectangle  Draws rectangles of different sizes and colors. Press and hold [Shift] to draw a perfect square.  

Oval  Draws oval shapes. Press and hold [Shift] to draw a perfect circle.  

Pencil  Draws freehand lines and shapes.  

Deco  Creates drawings and animation based on dynamic shapes and colors.  

Brush  Draws / paints with brush-like strokes.  

Ink Bottle  Applies color, thickness and styles to lines.  

Paint Bucket  Fills enclosed areas of a drawing with color.  

Eyedropper  Picks up styles of existing lines, fills, and text and applies them to other objects.  

Eraser  Erases lines and fills.  

Hand  Moves the view of the Stage and Work Area.  

Zoom  Increases or reduces the view of the Stage and Work Area.  
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EXPERIMENT No. 17 

DEMONSTRATE THE PROCEDURE TO CREATE AN ANIMATION USING FLASH. 

AIM: DEMONSTRATING THE PROCEDURE TO CREATE AN ANIMATION USING FLASH 

FLASH DOCUMENT SETUP 

 FLASH DOCUMENT’S SIZE AND SPEED SETUP 

 
 Size: default 550 X 400 pixels  

 Full screen:  1024 X 768 pixels, 800 X 600 pixels  

 Banner:  1000 X 100 pixels, 800 X 100 pixels  
 Speed: default 24 fps (frame per second)  

Try to do the setup as follows:  
1. Click on 550 X400 pixels button in the Properties Panel to change the document size  

2. Enter a value in the FPS edit box to change the speed.  

3. Click on the Stage’s swatch to choose background color.  

 

 

FIG 17.1 

NOTE: IF THE PROPERTIES PANEL IS NOT SHOWING THE DOCUMENT SETTING, CLICK ON THE STAGE FIRST, THEN IT WILL 

ACTIVATE THE DOCUMENT SETUP WINDOW. 
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CREATE ANIMATION 

 
Fig 17.2 

 Basic animation requires two keyframes: the starting key frame and the ending key frame. A key frame is a frame in which you define a 
change to an object’s properties for an animation or include Action Script code to control some aspect of your document.  

 The number of frames between two keyframes determines the length of the animation.  

 

IN FLASH CS6, THERE ARE 3 METHODS FOR CREATING AN ANIMATION SEQUENCE: CLASSIC TWEENING, SHAPE 

TWEENING AND MOTION TWEENING. IN THIS COURSE, WE FOCUS ON CLASSIC TWEENING AND SHAPE TWEENING. 
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In classic tweening, you define properties such as position, size, and rotation for an instance (editable copies of symbols that are placed on the 
stage), group, or text block at one point in time, and then you change those properties at another point in time.  
 

In shape tweening, you draw a shape at one point in time, and then you change that shape or draw another shape at another point in time.  
Basic steps to create a classic tweening in Flash: 

1. Create a starting key frame with object(s).  
2. Select the starting key frame on the layer of the timeline if it is not selected.  
3. Insert on the menu bar > Choose Classic Tween.  
 

 
Fig 17.3 

4. Click the ending key frame on the layer of the timeline, and then insert key frame (Insert on the menu bar > Choose Timeline >Click 
Key frame or by right-click Insert Key frame).  

5. Modify the content in the ending key frame.  
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Basic steps to create a shape tweening in Flash: 

 
1. Create a starting key frame with object(s).  
2. Select the starting key frame on the layer of the timeline if it is not selected.  
3. Insert on the menu bar > Choose Shape Tween.  
4. Click the ending key frame on the layer of the timeline, and then insert key frame (Insert on the menu bar > Choose Timeline > Click 

Key frame or right-click Insert Key frame).  
5. Modify the content in the ending key frame.  
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EXPERIMENT NO. 18 

PROCEDURE TO CREATE AN ANIMATION TO REPRESENT THE GROWING MOON. 

AIM: CREATING AN ANIMATION TO REPRESENT THE GROWING MOON. 

1. Open flash 8 software -> click on flash document->go to windows->properties ->select the properties tool-> choose the Background 

to black. 

2. Go to fill color under tool bar-> select the white color. 

3. Select the oval tool in order to draw the moon. u will get a white circle. 

4. Select the oval tool in order to draw the moon. u will get a white circle. 

5. Select the white circle on the worksheet using the selection tool->right click- >convert to symbol->select movie clip->give suitable name 

eg: moon->click ok. 

6. Go to filter->click on the + symbol->select glow to apply glowing effect-> select the color to white under glow and adjust the blur x/blur 

y values. 

7. Click on the + symbol again and chose blur-> again adjust the blur x/blur y values. 

8. Place the moon where ever you want on the work area. double click on layer 1 and rename as MOON. 

9. Insert another layer->rename it as Animation. 

10. Select the fill color to black-> select oval tool and draw a circle on the moon to cover the moon->select the newly added circle-> right 

click->convert to symbol->movie clip-> name it as Animation. 

11. Go to filter-> select + symbol->give the glow and blur effect as did for moon. 

12. Select the 150th frame in moon layer->right click->insert key frame. repeat the same for Animation layer. 

13. Click on the 149th keyframe of animation layer ->right click->press create motion-> select the animation movie clip and move slowly 

across the moon. 
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14. FINALLY GO TO CONTROL-> TEST MOVIE-> U WILL GET A GROWING MOON AS THE OUTPUT. 

 

OUT PUT: 

 

Fig 18.1 
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COMPUTER SCIENCE AND ENGINEERING 

Second Year (P.C. 319 / 72) 

PAPER – II: SQL, PHOTOSHOP & FLASH 

QUESTION BANK 
 

TIME :3HOURS MAX. MARKS :50 

 

Section-I        1 x 40 = 40Marks 
 

1. Demonstrate and execute procedure for create table with the name student with the columns admnno, stdname, 
phone number, grp, alter the properties of any two columns, rename the table student to student2019, describe the 
properties of the table student2019 and finally drop the table student2019 using ddl commands in sql. 

 
2. Create table with the name student, set admnno as primary key, insert ten records, modify the data of two students, 

delete two records from the table, , and display the data of the student table at each stage. 
 
3. Demonstrate different numeric functions with proper syntax and by taking examples. 
 
4. Demonstrate different string and date functions with proper syntax and by taking examples. 
 
5. Write a pl/sql program to check whether given number is Armstrong or not. 
 
6. Write a pl/sql program to print the factorial of a given number. 
 
7. Write a pl/sql program to print the Fibonacci series. 
 
8. Write a pl/sql program to check given string is palindrome or not. 
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9. WRITE A PL/SQL PROGRAM TO FIND SUM OF N NUMBERS. 

     10. Write a pl/sql program for addition of two numbers 
 

11. Write and demonstrate the purpose of tools in tool box of  Photoshop. 
 

12. Demonstrate using or selecting a tool and editing a tool preferences in Photoshop. 
 

13. Write and demonstrate the procedure to design a visiting card containing at least one graphic and text information and 
prepare a cover page for the book in your subject area using photo shop. Plan your own design. 

 
14. Write and demonstrate the procedure to extract the flower only from given photographic image and organise it on a 

background. Selecting your own background for organisation. Adjust the brightness and contrast of the picture so that 
it gives an elegant look using photo shop. 

 
15. Procedure to take a photographic image. Give a title for the image. Put the border. Write your names. Write the name 

of institution and place. Apply the effects shadow emboss using Photoshop. 
 

16. Demonstrate the work space of flash. 
 

17. Demonstrate the procedure to create an animation using flash. 
 

18. Procedure to create an animation to represent the growing moon. 
 
Section-II 

 

  Record  : 5 Marks 
  Viva   : 5 Marks 
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COMPUTER SCIENCE AND ENGINEERING 

Second Year (319/73) 

PAPER– III: INTRNET TECHNOLOGY 

INDEX 

 Sl.No.   Name of the Experiment       Page No. 

  
1.   Exposure to network connectivity Hardware Wiring     128    

2.   Establish network connectivity using Wired  devices Modem and Network  

Interface Card           132 

3.   Establish Network Connection using  Dial up connection      138 

4.   Establish Network Connection using  ISDN connection      141 

5.   Usage  of Public  Internet Services for the following     144 

a. Email  b. File Transfer 

6.   Usage  of Public  Internet Services for the following     149 

a. Internet Fax b. Web Surfing 

7.   Trouble shooting           159 

a. Diagnose the problem when the computer does not run properly. 

b. How trouble shoot when the printer is not printing. 
8.   Troubleshooting           161 

a. Trouble shoot the problem when the keyboard does not respond and  
Constant beeping noise when booting up 

b. Diagnose mouse when acting as erratic. 

c. Trouble shoot when the computer has no sound and also no sound is heard  
From audio media 
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9.   HTML code using Basic tags for a website - HTML, head, title, body.   165 

10.   HTML code using tags for Text: <p>, <b>, <block quote>,    167 

headings: <h1>, ….<h6>, bold, italic and horizontal line tags. 
11.   Write  HTML code using tags for lists: Ordered and unordered list   169 

12.   Write HTML code using tags for hyperlinks.      172 

13.   Write  HTML code using tags for Images       174 

14.   Write  HTML code using tags for Tables       175 

15.   Write  HTML code using tags for creating Forms      177 

16.  Creating a website to display the information about your college   179 
17.   Create a website for a product company to display their product and price.  182 

 
 

Question Bank           184 
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Experiment1: 

Exposure to network connectivity Hardware Wiring 

Aim:  

This lab aim to construct straight through cable, used to connect computer to the Switch/Hub. It is used to connect dissimilar devices. While 

cross cable is used to connect to computers directly. It is also used when you connect to hubs/Switches with a normal port on both hubs/Switches. 

(In other words, the cross cable is used relatively in a rare case.). It is used to connect similar devices. 

Straight through cable 

Requirements: RJ-45 connector, Crimping Tool, Twisted pair Cable 

Procedure: To do these practical following steps should be done 

1. Start by stripping off about 2 inches of the plastic jacket off the end of the cable. Be very careful at this point, as to no tnicko 
rcutin to the wires, which are inside .Doing socoul dalter the characteristic sof you rcable, or even worse rend erisuseless .Check 
the wires, one more time for nicks or cuts. If there are any, just whack the whole end off, and start over. 

 
2. Spread the wires apart, but besureto hold on to the base of the jacke twith your other hand. You do not want the wires to 
become untwisted down inside the jacket. Category 5 cable mustonlyhave1/2ofaninchof'untwisted'wireattheend; other wise I will 
be 'outofspec'. At this point, you obviously have ALO T morethan1/2ofan in chofun-twistedwire. 

 
3. Youhave2endjacks,which must be installed on your cable .If you are usingapre-made cable, with one of the ends whacked off, 
you only have one end to install - the crossed over end .Below are two diagrams ,which show how you need to arrange the cables 
for each type of cable end. Decide at this point which end you are making and examine the associated picture below. 
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DIAGRAM SHOWS YOU HOW TO PREPARE CROSS WIRED CONNECTION 

DIAGRAM SHOWS YOU HOW TO PREPARE STRAIGHT THROUGH WIRED CONNECTION 
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4. LAN cable is now ready for communication in the network . this is can be verified by ping command to neighbour network IP address. 

 Goto  

Start -> Run  

 Type ping command as showed example 

Example  

ping -t 10.10.100.90 
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Expected Output 

 

 

 

 

 

Actual Output: 
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Experiment2: 

Establish network connectivity using wired devices Modem and Network Interface Card 

Aim:  

This lab aim to construct straight through cable, used to connect computer to the Switch/Hub. It is used to connect dissimilar devices. While 

cross cable is used to connect to computers directly. It is also used when you connect to hubs/Switches with a normal port on both hubs/Switches. 

(In other words, the cross cable is used relatively in a rare case.). It is used to connect similar devices. 

Straight through cable 

Requirements: Broadband Modem, RJ-45 connector, Crimping Tool, CAT 6 Cable 

Procedure: To do these practical following steps should be done 

STEP 1. Shut your computer down and disconnect the power cable from the back of your broadband modem. If you have an Ethernet or wireless 

router, disconnect the power cable from it as well. 

STEP 2. Connect an Ethernet cable to the back of the broadband modem and to your computer's Ethernet port. If you're using a router, you'll 

need a second Ethernet cable. Connect one cable to the broadband modem and to the port marked "WAN" or "Internet" on the router. Connect 

the second cable to one of the router's numbered ports and to your computer's Ethernet port 

STEP 3. Connect the power cable to the broadband modem and wait for it to connect to the Internet Service Provider. This usually takes less 

than one minute. The indicator lights on the front of the modem should turn solid when the modem is connected. Connect the power cable to the 

router, if applicable, and wait several seconds for it to establish communication with the modem. 

STEP 4. Turn on your computer and launch a Web browser when Windows finishes loading. If your computer is able to browse the Web, stop 

here. If not, continue. 
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STEP 5. Open the "Start" menu, click "Control Panel" and select the "Network and Internet" heading. In the new window, click the "Network 

and Sharing Center" heading and then click the "Change Adapter Settings" link in the left column. The "Network Connections" window appears. 

 go to  

Start->Control Panel -> Network and Internet -> Network and Sharing Center -> Change Adapter Settings  
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STEP 6. Examine the "Local Area Connection" icon. If it displays the message "Network cable unplugged," remove and re-set the Ethernet 

cable between your computer and router or modem. If you continue to see the message, replace the Ethernet cable. 

 

STEP 7. Right-click the "Local Area Connection" icon and select "Properties" from the popup menu. In the new window, double-click "Internet 

Protocol Version 4 (TCP/IP)."  
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STEP 8. Click the "Obtain an IP address automatically" and "Obtain DNS server address automatically" radio buttons, click "OK" in every 

window and restart the computer. When the computer finishes restarting, the Internet connection should work properly. 

 

 

STEP  9. If in case automatic IP address are not obtain then select the IP Address and DNS server Address radio button manually and type your 

IP Address and DNS Server address manually like as follows. 
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Expected Output: 

1. Open Browser  

2. Type http://bieap.gov.in/Secondyrmodelpaper.aspx URL 

3. Click on any one of the paper and download 

Actual Output:  ( if your are downloaded write URL of the respective downloaded file) 
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Expected Output: 

1. Open Browser  

2. Type http://bieap.gov.in/Voctextbooks.aspx URL 

3. Go to respective Subject 

4. Click on any one of the subject and download pdf file 

Actual Output: ( if your are downloaded write URL of the respective downloaded file ) 
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Experiment3: 

Establish Network Connection using Dial up 

Requirements: 

1. Dial up modem 

By default, Windows 7 computers do not come with dial-up modems built in. You may need to have one installed by a computer technician, or a 

USB plug-in dialup modem may be available for purchase at your local computer store. 

You can check the Device Manager to confirm if there is a dial-up modem installed by doing the following: 

Procedure: 

1. Open the Start menu and select Control Panel.  
2. Select Network and Sharing Centre. 
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3. Click Set up a new connection or network.  
  

 

 

4. Select Dial-up.  
5. Fill in the form with the following and then click Create.  

Dial-up phone number: 0198333955 

User name: Your West net dialup username (e.g. example@westnet.com.au) 
Password: Your West net dialup password 
  

6. The Wizard will attempt to connect to the dialup internet. If it fails (for example, the phone line is occupied by a phone call) ignore the 
error message and click Skip and try to connect again when the phone line isn't busy.  

7. Once the connection is established, your computer should be online. 

 Tip: In Control Panel > Network and Internet > Network Connections, you'll find the the dialup icon listed. If you dial up using this 

icon, a dialog box will return an error code number if it's unsuccessful. This error number is useful for troubleshooting your connection. 
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Expected Output: 

Sending a file from Server to client 

Actual output: (Write the status of the file whether it is received or not) 
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Experiment4 

Establish Network Connection using ISDN 

Requirements: 

1. ISDN modem 

An ISDN connection is an Internet connection established with a ISDN modem card through a special phone line installed by the phone 

company. ISDN connections are popular in Europe. 

To add an ISDN connection, follow these steps: 

1. Click the Devices tab. 

2. Click the New button on the toolbar. 

3. Select ISDN connection from the Device Type list, and click Forward. 

4. Select the ISDN adapter from the pull down menu. Then configure the resources and D channel protocol for the adapter. 
Click Forward to continue. 
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Fig 3.1: ISDN Settings 

5. If your Internet Service Provider (ISP) is in the pre-configured list, select it. Otherwise, enter the required information about your ISP 
account. If you do not know the values, contact your ISP. Click Forward. 

6. In the IP Settings window, select the Encapsulation Mode and whether to obtain an IP address automatically or to set a static IP 
instead. Click Forward when finished. 

7. On the Create Dialup Connection page, click Apply. 

After configuring the ISDN device, it appears in the device list as a device with type ISDN as shown in Fig3.2 

Be sure to select File > Save to save the changes. 

After adding the ISDN device, you can edit its configuration by selecting the device from the device list and clicking Edit. For example, when 

the device is added, it is configured not to start at boot time by default. Edit its configuration to modify this setting. Compression, PPP options, 

login name, password, and more can be changed. 

When the device is added, it is not activated immediately, as seen by its Inactive status. To activate the device, select it from the device list, and 

click the Activate button. If the system is configured to activate the device when the computer starts (the default), this step does not have to be 

performed again. 
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Fig3.2: ISDN Device 

 

 

Expected Output: 

Sending a file from Server to client 

Actual output: (Write the status of the file whether it is received or not) 
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Experiment 5 

Usage of Public Internet Services for the following 

 Email 

 File Transfer 

Aim: students are able to get the knowledge in the usage of Public Internet Services 

Requirements: Web browsers like Google Chrome 

Procedure: 

E-mail 

Email stands for electronic mail, is one of the mostly used features of Internet along with the web. It is used to send and receive messages 

to anyone from anywhere in the world. However, if you use an email client like Microsoft Outlook or Apple Mail, you need to manually 

configure each account. Besides the email address and password, you may also have to enter the incoming and outgoing mail servers and enter 

the correct port numbers for each one. 

Some of the emails are: 

 Gmail 

 Hot Mail 

 Yahoo Mail 

Procedure to create an email account: 

1. Open the browser. 

2. Type the address of the mail server in the address bar like, 

3. www.gmail.com, www.mail.yahoo.com, www.hotmail.com, 

4. Select “Signup” button or link in the webpage. 
5. Provide the required information in the web page like, Name, alternate email, user id, 
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6. password, retype password, date of birth etc., 

7. Type the security password and select “ok” or “proceed” or “Create account” button. 
Procedure to open a Mail box: 

1. You must open your email account provider such as Gmail, yahoo or rediff etc., 

2. Login into your email-id by using user name and password. 

3. Select Login button. 

Procedure to compose an email: 

1. After logged in , click on compose 

2. Enter address of the receiver(s) in the "To" field 

3. You must write the subject that means email is for what purpose in the “subject “field 

4. You must write in the contents of your email in message box. 

Steps to attach files: 

If you want to attach files, 

1. Click on “Pin symbol” 

2. Go to the location where the file is saved to be attached. 

3. Select the file. 

4. Select “Attach” button or “ok” button”. 

Steps to sending an email: 

1. After composing the email 

2. Click on "Send" button to send the composed mail. 

b. If everything is correct , then you will be noticed that 
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“your message has been sent, view message”. 

Expected Output: 

1. Create a mail account and Compose a leave letter with attaching file 

 

Actual Output:  

(Click on send button to send the mail.) 
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File transfer 

File transfer is the process of moving a file from one place to another place. It enables sharing a file between different computers locally and 

remotely. A file transfer may be upload or download. FTP, HTTP are the most common file transfer protocols used in computer networks. 

Other than network or Internet, file transfer can be manually performed by copying a file to new folder in same computer. File transfers can also 

be done by using USB, pen drive, CD to transfer files from one computer to another computer. 

Steps to transfer file using online service: 

Step 1: Open the web browser. 

Step 2: Enter the URL www.webcargo.net. 

Step 3: Click on link button and select the file from your computer. 

 
Step 4: After selecting the file it asks for your e-mail, email address for whom you want to send files, subject and message. 
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Step 5: Click on send button, immediately it displays the delivery confirmation message. 

 

Expected Output: 

Send the file to the neighbor email address 

Actual Output: (paste or check the status of the neighbor email address whether it is received or not ) 
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Experiment 6 

Usage of Public Internet Services for the following 

 Internet Fax 

 Web Surfing 

Aim: students are able to get the knowledge in the usage of Public Internet Services 

Requirements: Web browsers like Google Chrome 

Procedure: 

A) Internet Fax: 

Internet fax, e-fax is used to send a fax rather than a standard telephone connection and a fax machine. The difference between Internet fax and 
other Internet communications such as email is the ability to exchange fax messages with traditional telephone-based fax machines. 

Steps to send fax by using online service: 

If there is a problem to connect your phone line to your PC then we are can send fax through online websites like eFax and GotFreeFax.com. 

Many websites let you to send certain amount of data for free. 

Step1: Go to faxzero.com then fill out the required sender and 

receiver information.  
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Step 2: Click the Choose file button to upload documents. If you have physical document, you scan those documents then you upload. 

 

 

 

 
Step 3: Enter the confirmation code that appears on the site. So that computer understands that you are human and not an automated program. 

Then click on Send free fax now button. 
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B) Web surfing: 

Web surfing means moving from one page to another page on the web. Just like TV channel surfing where one clicks the remote to go from one 

channel to another channel. The hyperlinks on web pages make it easy to move from one page to another page. 

Surfing gets started with the arrival of World Wide Web. Surfing is favourite for millions of people around the world who have access to the 

Internet. Many users spend plenty of time for casual searches or other online activities. Some may surf to kill the time. 

Procedure for getting online bus ticket (www.redbus.in) 

Procedure for getting online bus ticket (www.redbus.in) 

Step 1: Open “Web Browser”. 
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Step 2: Type the web site address” www.redbus.in” at address bar of the “Web Browser”. 

 

 

Step 3: Type the “Source (from)” and “Destination (to) stations in “from” and “to” text fields. 
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Step 4:Select the “date of Journey” from the “date of journey “ field. 

 

Step 5: Select “Search Buses” button from the window. 

Different types of Travel maintain services between source and Destination are displayed with 

details a) Arrival Time b) Departure time c) Total number of seats in the service and d) Fare 
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Step 6: Select one travel from the list shown Ex: Svkdt travels and select 

”View Seats” button. 

The seat positions are displayed in 4 types i.e., 1) Available seat 2)Reserved for ladies 3)Selected seat and 

4)Booked Seat. 
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Step 7: Select “Seat” position from the available blank seats. 

Selected seat highlighted with white colour. 
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Step 8: Select the boarding point from the drop down list “Choose boarding point” 

 

Step 9: Select the dropping point from the drop down list “Choose dropping point” 
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Step 10: Select “proceed to book” Button. 

Step 11: Provide the details of the passenger Name, Gender, Age, E – mail and Mobile 

Numbers in the corresponding fields. 
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Step 12: 

Select one type of payment “Credit Card”, “Debit Card” “Net Banking” , “Cash on Delivery”, 

“Wallets” or “pay U Money”. 

Select the radio button for type of card. 

Provide “Card Number” 

Select “Expiry month and year of the card” 

Type the “CVV” from the image displayed. 

Select the button “Book Now” 
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Step 13: Login to the web site of the corresponding bank and confirm the payment. 

Step 14: Take the print out of the confirmed ticket. 

 

Expected Output: 

Check the bus ticket availability form Hyderabad to your nearest Home town 

Actual Output: (write the ticket availability status and cost of the bus ) 
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Experiment 7  

Troubleshooting 

a) Diagnose the problem when the computer does not run properly. 

b) How trouble shoot when the printer is not printing. 

Description: Troubleshooting is the process of figuring out how to solve a computer problem. Even with the most updated software and 

hardware, occasionally computers can malfunction. In order to solve a problem, you must figure out which part of the system is malfunctioning. 

You will need to check each component of the computer, unless it is obvious where the problem is coming from. Isolating the problem will help 

you solve the problem quickly. Knowing how to solve these problems with a shortcut perhaps using only a few keys on the keyboard can save 

time and effort. Backing up your important computer files to another source will ensure that if your problem cannot be corrected, you will still 

have a safe copy of your information. 

 

a ) Diagnose the problem when the computer does not run properly. 

Procedure : 

 

STEP 1 Close open programs and windows you are not currently using. 

STEP 2 Make sure all of your cords are connected properly. 

STEP 3 Try to repeat the sequence of commands you performed before the problem occurred. See if this causes the same response by your 
computer. 

STEP 4 Press the F1 key to access the Help window. You can search for a solution to your problem once the Help window appears. 
STEP 5 If there is an error message, record the full message for future reference. 

STEP 6 Restart your computer to see if it clears the problem. To restart your computer, open the start window and select the Restart button 
instead of the Log Off button. 

STEP 7 If restarting the computer does not clear the problem, shut down the computer and then start it back up again. 
STEP 8 If the issue is still not resolved, check the common technology issues below or call your system administrator. 
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Actual Observation(s): 

 

 

b) How trouble shoot when the printer is not printing. 

Procedure: 

STEP 1 Don't forget that each printer comes with "driver" software that must be installed on the computer before you can print. If you buy 
a new printer for your old computer, or you buy a new computer and you want to put your old printer on it, you must install the 
printer's driver software. 

STEP 2 Make sure that the printer is turned on and that the printer cable is firmly connected to the printer and to the computer. Jiggle the 
wires. 

STEP 3 Check that the printer has paper and that the ink cartridge is not empty. (Ordinarily you will get a specific message if the painter is 
out of paper or ink.) 

STEP 4 Make sure that the correct printer is selected. The Print dialog box (which you get when you select File =>Print) shows the 
available printers in a list at the top. If there has ever been more than one printer attached to your computer, then it's possible that the 
wrong one is selected. Click on the icon for the correct printer and proceed. 

STEP 5 If a printer icon shows up in the System Tray (lower right corner of the screen), click on it to see what is in the print buffer. If the 
buffer is empty, then the printer either you have not yet issued the Print command or the printer has already printed the document. 
Note that sometimes an ink jet printer will pause for several seconds for no apparent reason before or while printing. This is normal - 
give it time. 

STEP 6 Unplug the printer's USB cable and plug it back in again. 
STEP 7 Try plugging the printer into one of the other USB ports of your computer. 
STEP 8 Turn the printer off and back on-again. 
STEP 9 Re-boot the computer. It's amazing how often this solves strange problems. 

STEP 10 Re-install the printer driver from the original disk that came with the printer. 

STEP 11 Check your printer's manual to learn how to produce a self-test printout from the printer itself (perhaps by pressing one or more of 
the printer's buttons while powering up the printer). If the self-test works, then the printer itself is working and the problem may lie in 
the cable or computer software. If the self-test does not work, then the printer has a problem. 

Actual Observation(s): 
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Experiment 8  

Troubleshooting 

a) Trouble shoot the problem when the keyboard does not respond and constant beeping noise when booting up 

b) Diagnose mouse when acting as erratic. 

c) Trouble shoot when the computer has no sound and also no sound is heard from audio media 

Description: Troubleshooting is the process of figuring out how to solve a computer problem. Even with the most updated software and 

hardware, occasionally computers can malfunction. In order to solve a problem, you must figure out which part of the system is malfunctioning. 

You will need to check each component of the computer, unless it is obvious where the problem is coming from. Isolating the problem will help 

you solve the problem quickly. Knowing how to solve these problems with a shortcut perhaps using only a few keys on the keyboard can save 

time and effort. Backing up your important computer files to another source will ensure that if your problem cannot be corrected, you will still 

have a safe copy of your information. 

 

a) Trouble shoots the problem when the keyboard does not respond and constant beeping noise when booting up 

Procedure: 

 

STEP 1 Make sure the keyboard is connected to the computer. If not, connect it to the computer. 

STEP 2 If you are using a wireless keyboard, try changing the batteries. 

STEP 3 If one of the keys on your keyboard gets stuck, turn the computer off and clean with a damp cloth. 
STEP 4 Use the mouse to restart the computer. 

Note: when in the keyboard does not respond and constant beeping noise at time of  booting,  just unplug the keyboard and replace with 

new keyboard. 

 



 

164  

Actual Observation(s): 

b) Diagnose mouse when acting as erratic. 

Procedure: 

STEP 1 Check if the mouse is securely plugged into the computer. If not, plug it incompletely. 

STEP 2 Check to see if the cord has been damaged. If so, the mouse may need replacing. 

STEP 3 If you are using a cordless mouse, try pushing the connection button on the underside of the mouse to reestablish a connection. 
STEP 4 Clean the mouse, especially on the bottom. 

 

Actual Observation(s): 

 

 

c) trouble shoot when the computer has no sound and also no sound is heard from audio media 

Procedure: 

STEP 1 Double-click on the volume control (little loudspeaker icon) in the taskbar (lower rightcornerof the screen). If the volume control 
icon is not among the little icons in the lower right of the screen, click Start =>Settings =>Control Panel =>Sound and Audio 

Devices and check "Place volume icon in the taskbar". 

STEP 2 Make sure that none of the Mute boxes are checked and that none of the volume sliders are turned all the way down. Click to un-
check a mute box. Close the window. 

STEP 3 If you have speakers attached to your computer, make sure they are plugged in and turned on (there will usually be a small 
pilot light that indicates when it's turned on). Check volume control on the speakers or headphones - make sure it is not turned 
all the way down. 

STEP 4 Make sure the speakers or headphones are connected to the computer correctly.  They must  be connected to the audio output 
socket on the back of the computer; this will be marked with a small picture of headphone or of a speaker. Make sure it's not 
connected to the microphone input (marked with a picture of a microphone). Make sure the cable is firmly plugged in. Jiggle 
the wires. 
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STEP 5 If you have been working with several sound-related programs that have their own volume controls, such as sound players 
like Real Audio, Music Match, Win Amp, etc, then it's possible that their volume controls may interact. Open them up and 
make sure that their volume controls are turned up. 

STEP 6 If sound is not working only on one program, but other programs sound OK, then the problem is the settings of that program. 

Note: 

How can I control what sound my computer makes for common actions? 

Start =>Settings =>Control Panel =>Sounds and audio Devices. Click on the Sounds tab. 

To turn action sounds off, select "No Sounds" from the "Sound Scheme" menu (does not affect normal sound). 

 

Actual Observation(s): 

 

Some common trouble shooting PCs are listed below. 

How can I get the list of common tasks on the left side of every folder window? 

In Windows XP or Me, select Tools =>Folder Options..., then click "Show common tasks in folders". Unfortunately, Windows 98 does not 

have this feature. 

A. HOW CAN I CONTROL WHETHER "MY COMPUTERS", "MY DOCUMENTS", "MY NETWORK PLACES", AND "INTERNET 
EXPLORER" ARE DISPLAYED ON MYDESKTOP? 

Right-click on the desktop, select Properties. Click on the Desktop tab, then click Customize Desktop. Click the items in the list to add to 

or remove from the desktop. 

B. HOW CAN I VIEW DETAILS OF FILES IN A FOLDER, SUCH AS SIZE, TYPE, AND DATECREATED? 

Select View =>Details. To select which details to show, select View =>Choose Details. 

C. HOW CAN I VIEW THUMBNAILS OF PHOTO FILES IN AFOLDER? 
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Select View =>Thumbnails. Works in Windows XP, Me, and 2000, but not in 98. To see previews of selected photo files in Windows 98, 

select View =>as Web Page. 

D. THE ICONS AND TEXT ON THE DESKTOP ARE TOO SMALL FOR ME TO SEECLEARLY 

1. Right-click on the desktop and select Properties. 

2. Click the Setting stab. 

3. Drag the Screen resolution slider to the left (It's called Screen area in Windows98). 

4. Click Apply to see if this new setting is adequate. 

5. If not, try another setting. If so, click OK. If that's not enough, buy a bigger monitor. 

H. HOW CAN I CHANGE THE DESKTOP BACKGROUND PICTURE? 

1. Right-click on the desktop and select Properties. 

2. Click the Desktop tab (Background in Windows98). 

3. To use one of the built-in picture backgrounds, select one from the Background list. 

4. To use one of your own pictures as a background, click Browse, select Files of Type: All Picture files, browse to the location of 
your photo, and click Open. 

5. Click Apply to see if this new setting is adequate. 
 

 

6. If not, try another setting. If so, clickOK. 

G. HOW CAN I CHANGE MY SCREEN SAVER? 

Right-click on the desktop, select Properties. Click on the Screen Saver tab. You can select a screen saver from the Screen Saver pop-up 
menu, then click the Preview button to test it. (Note: To use your own pictures as a background, select the "My Pictures Slideshow" 
screensaver, click Settings, click Browse, scroll through the3 list of folders and click on the folder containing the pictures you want to 
show, and finally click OK three times). 

F. HOW CAN I CONTROL HOW LONG MY COMPUTER SITS BEFORE TURNING OFF THE MONITOR, ETC? 
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Right-click on the desktop, select Properties. Click on the Screen Saver tab, click Power.... and select an appropriate Power scheme from 

the menu. Typical settings for a desktop system: 15 minutes, Never, 30 min, 1 hour. For a laptop: 15 minutes, 30 minutes, 20 min, 3 hours. 

G. THE TASK BAR IS IN THE WRONG PLACE (OR ISMISSING)! 

You may have accidentally dragged the task bar.  You can drag the task bar to the left, right, top, or bottom of the screen. The normal 
place is the bottom. You can also drag its upper edge (mouse pointer changes to a ) to make it fatter or skinnier. You may have 
accidentally dragged it down to the very bottom of the screen so it's just a tiny line. Drag it backup. 

i. Mouse pointer moves so fast it's hard to control: Select Start =>Settings =>Control Panel. Double-click on Mouse.  Click the Pointer 

Options tab. Where it says "Select a pointer speed", drag the slider to the left a little bit (towards "slower"), click the Apply button in the 
lower right and test the mouse motion. Click OK when you are satisfied and close the Control Panel. 

j. My mouse pointer sticks, skips and jumps: Your mouse may need cleaning. If it's a mechanical rolling-ball mouse, remove the ball 
and clean the inside rollers, removing the accumulated gunk with your fingernails or with a moistened Q-tip. Blow out the debris with 
your breath or with a can of compressed air. Long term solution: replace your mechanical mouse with an optical mouse ($10 - $25): 
they don't need cleaning soften. 
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Experiment9 

HTML code using Basic tags for a website -  HTML, head, title, body. 
Aim: To write a code using basic tags. 

Requirements: Note Pad, Internet Explorer 

Program: 

 

 <!DOCTYPE html> 

<html> 

<head> 

<title> 

   This is my title for my webpage. 

  </title> 

</head> 

<body> 

   This is the body of my web page. 

</body> 

</html> 

Expected Output:  

        Actual Output: 
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Experiment 10 

HTML code using tags for Text: <p>, <b>, <block quote>, headings: <h1>, ….<h6>, bold, italic and horizontal line 
tags. 

Aim: To write a code using tags for text. 

Requirements: Note Pad, Internet Explorer 

Program: 

   

 <!DOCTYPE html> 

<html> 

<body> 

<h1>This is heading 1</h1> 

<h2>This is heading 2</h2> 

<h3>This is heading 3</h3> 

<h4>This is heading 4</h4> 

<h5>This is heading 5</h5> 

<h6>This is heading 6</h6> 

<hr> 

<p><i>This is first paragraph in italic</i></p><br> 

<p><b>This is second paragraph in bold</b></p><br> 

<p>I am <del> deleted </del>text </p> 

<p>I AM <small>SMALL</small></p> 

<p>I am <mark> marked </mark> text</p> 

<p>In general bowsers give indent to block quotes as follow</p> 

<block quote> 
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For 50 years, WWF has been protecting the future of nature. 

The world's leading conservation organization, 

WWF works in 100 countries and is supported by 

1.2 million members in the United States and 

close to 5 million globally. 

</block quote> 

 

</body> 

</html> 

Expected Output:   
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Actual Output: 

Experiment 11  

Write HTML code using tags for lists: Ordered and unordered list 
Aim: To write a code using tags for list. 

Requirements: Note Pad, Internet Explorer 

Program: 
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<!DOCTYPE html> 
<html> 
<body> 
<h2>An unordered HTML list</h2> 
<ul> 
<li>item 1</li> 
<li>item 2</li> 
<li>item 3</li> 
</ul> 
<h2>Unordered List with Square Bullets</h2> 

<ul style="list-style-type: square;"> 

<li>item 1</li> 

<li>Tea</li> 

<li>Milk</li> 

</ul> 
<h2>An ordered HTML list</h2> 
<ol> 
<li>item 1</li> 
<li>item 2</li> 
<li>item 3</li> 
</ol> 
<h2>Ordered List with Letters</h2> 

<ol type="A"> 

<li>item 1</li> 

<li>item 2</li> 

<li>item 3</li> 

 

 



 

173  

 

</ol> 

</body> 
</html> 
 
Expected Output:   

 
 
 

Actual Output: 
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Experiment12  

Write  HTML code using tags for hyperlinks 
Aim: To write a code using tags for hyperlink. 

Requirements: Note Pad, Internet Explorer 

Program: 

<!DOCTYPE html> 

<html> 

<body> 

<center> 

<h2>Example for Hyperlink</h2> 

<a href="https://www.google.com/gmail/" target="_blank">Open Gmail</a> 

<br> 

<br> 

<a href="https://www.facebook.com/" target="_blank">Open Face Book</a> 

<br> 

<br> 

<a href="https://twitter.com/login?lang=en" target="_blank">Open Twitter</a> 

<br> 

<br> 

</center> 

</body> 

</html> 
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Expected Output: 

 
    

Actual Output: 
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Experiment13  

Write  HTML code using tags for Images 
Aim: To write a code using tags for images. 

Requirements: Note Pad, Internet Explorer 

Program: 

<!DOCTYPE html> 

<html> 

<body> 

<center> 

<h2>Example for Hyperlink</h2> 

<marquee direction =left"> 

<img src="E:\mk\vocational\final\finalbook\lab\latest\1.jpg" width="256" height="256"><br><br> 

<img src="C:\Users\pscmr1\Desktop\2.jpg " width="256" height="256"><br><br> 

</marquee> 

</center> 
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</body> 

</html> 

Expected Output: (Scrolled the images )     Actual Output: 

 

 

 

 

 

 

 

 

 

Experiment14  

Write  HTML code using tags for Tables 
Aim: To write a code using tags for tables. 

Requirements: Note Pad, Internet Explorer 

Program: 

<!DOCTYPE html> 

<html> 

<body> 

<center> 

<h2>Member Details</h2> 

<br> 

<table style="width:50%"> 

<tr> 

<th align="center">First name</th> 

<th align="center">Last name</th> 

<th align="center">Age</th> 

</tr> 
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<tr> 

<td align="center">John</td> 

<td align="center">Doe</td> 

<td align="center">80</td> 

</tr> 

<tr> 

<td align="center">louis</td> 

<td align="center">mary</td> 

<td align="center">65</td> 

</tr> 

<tr> 

<td align="center">huckleberry</td> 

<td align="center">finn</td> 

<td align="center">85</td> 

</tr> 

<tr> 

 

 

 

<td align="center">John</td> 

<td align="center">watson</td> 

<td align="center">70</td> 

</tr> 

</table> 

</center> 

</body> 

</html> 

 

Expected Output:  
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Actual Output: 

Experiment 15  

Write  HTML code using tags for creating Forms 

Aim: To write a code using tags for creating forms 

Requirements: Note Pad, Internet Explorer 

Program: 

<!DOCTYPE html> 
<html> 
<body> 
<center> 
<h2>HTML Forms</h2> 
<form action="/action_page.php"> 
  First name:<br> 
<input type="text" name="first name" value="Mickey"> 
<br> 
  Last name:<br> 



 

180  

<input type="text" name="last name" value="Mouse"> 
<br><br> 
<input type="submit" value="Submit"> 
</form> 
<p>If you click the "Submit" button, the form-data will be sent to a page called "/action_page.php".</p> 
</center> 
</body> 
</html> 
 

 

 

 

 

 

 

 

 

 

Expected Output:  
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Actual Output: 

 

 

 

 

 

Experiment16  

Creating a website to display the information about your college 
<html> 
<body bicolor="pink"> 
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<center> 
<h1>ABC COLLEGE OF ENGINEERING AND TECHNOLOGY</h1> 
</center> 
<center> 
<hr> 
<table> 
<tr> 
<td>&nbsp&nbsp&nbsp<a href="#"><font size="4" color="blue">Home</font></a>&nbsp&nbsp&nbsp</td> 
<td>&nbsp&nbsp&nbsp<a href="#"><font size="4" color="blue">About</font></a>&nbsp&nbsp&nbsp</td> 
<td>&nbsp&nbsp&nbsp<a href="#"><font size="4" color="blue">Branches</font></a>&nbsp&nbsp&nbsp</td> 
<td>&nbsp&nbsp&nbsp<a href="#"><font size="4" color="blue">Contact us</font></a>&nbsp&nbsp&nbsp</td> 
</tr> 
</font> 
</table> 
<hr> 
</center> 
<p> 
<b>Vision:</b><br> 
To make a significant contribution to the evolution of a highly advanced technological society with profound human values by nurturing students 
with unparallel expertise and a high sense of ethics. 
</p> 
<b>Mission:</b><br> 
To offer a high quality professional education and training blended with a high sense of discipline and ethics to shape the students into people 
who can play an effective role in the development of a knowledge society and thereby striving to bring the light into the lives around them with 
human outlook. 
</body> 
</html> 
 

The above code gives the basic view of how to display a college information in a web page. 

 

 <body> tag gives the entire representation of body where every other  tags are embedded in this body tag. 

 bgcolorattribute in the body tag gives back ground colour to the body. 
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 <center>tag is used to align components to centre. 

 <hr>tag is used to separate the content in HTML page. 

 <table>tag facilitates with the all table  related components such as row tag <tr> data tag <td> etc. 

 &nbsp allows you to create multiple spaces that are visible on a web page which is a non-breaking space. 

 <a>tag provides the hyperlink facility where links are provided in the webpage to redirect to other source. 

 <font> tag is used to set the font style, size and colour of the text. 

 <p> is used to define a paragraph. 

 <b>tag is used to define the text to be bold. 
 

Every tag should be closed accordingly in order to get effective webpage without any errors. One can use different tags as per the requirements 
and can design the desired webpage 
Expected Output:  
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. 

 

 

Actual Output: 
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Experiment17  

Create a website for a product company to display their product and price. 
Aim: To Create a website for a product company to display product information 

Requirements: Note Pad, Internet Explorer 

Program: 

 

<html> 

<body bgcolor="pink"> 

<center><h1>ABC Shopping</h1></center> 

<center> 

<hr> 

<table> 

<tr><td>&nbsp&nbsp&nbsp<a href="#"><font size="4" 

color="blue">Home</font></a>&nbsp&nbsp&nbsp</td><td>&nbsp&nbsp&nbsp<a href="#"><font size="4" 

color="blue">About</font></a>&nbsp&nbsp&nbsp</td><td>&nbsp&nbsp&nbsp<a href="#"><font size="4" 

color="blue">Items</font></a>&nbsp&nbsp&nbsp</td><td>&nbsp&nbsp&nbsp<a href="#"><font size="4" color="blue">Contact 

us</font></a>&nbsp&nbsp&nbsp</td></tr> 

</font> 

</table> 

<hr></center><table><tr> 

<td> 

<img src="http://2.bp.blogspot.com/-

7wKtrju4WPA/URH1SO0LKmI/AAAAAAAAHY0/sLSk5BAqQPk/s1600/everyone+a+reader.jpg" width="300" height="300"> 

<br> 

<b>Title:</b>Book 1<br><b>Price:</b>10000<br> 

</td> 

<td><img src="https://i.pinimg.com/736x/57/22/7a/57227aa3cf41be318ba4a6ba58b04005.jpg" width="300" height="300"> 

<br><b>Title:</b>book 2<br><b>Price:</b>10000<br> 

</td> 

<td> 
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<img src="http://1.bp.blogspot.com/_yPL3t1DDDMg/TKVBsMUiVoI/AAAAAAAAAAc/9MtZQZYVN_Q/s1600/Books.jpg" 

width="300" height="300"> 

<br><b>Title:</b>book 3<br><b>Price:</b>10000<br> 

</td> 

</tr></table> 

</body> 

</html> 

 <img> tag in the above code gives the facility to display an image in the webpage. 

 src attribute in the img tag is used to browse the image from specified url and display it in the webpage. 
The above code uses the many similar tags used commonly. One can improvise the webpage and can it accordingly. 

 

Expected Output: 

 
 

 

 

Actual Output: 
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COMPUTER SCIENCE AND ENGINEERING 

Second Year (319/73) 

PAPER – III: INTERNET TECHNOLOGY 

QUESTION BANK 

TIME: 3HOURS                                 MAX. MARKS: 50 

 

Section-I        1 x 40 = 40Marks 
 

1. Write and demonstrate the procedure for network connectivity Hardware Wiring 

2. Write and demonstrate the procedure to establish network connectivity using Wired  devices Modem and Network 

Interface Card 

3. Write and demonstrate the procedure to establish Network Connection using Dial up  

4. Write and demonstrate the procedure to establish Network Connection using ISDN connection 

5. Write and demonstrate the procedure to send an Email and File transfer 

6. Write and demonstrate the procedure to send an Internet Fax and  Web Surfing 

7. Write and demonstrate the procedure to rectify the trouble shoot of the  following 

a) Diagnose the problem when the computer does not run properly. 

b) How trouble shoot when the printer is not printing. 

8. Write and demonstrate the procedure to rectify the trouble shoot of the  following 

a) Trouble shoot the problem when the keyboard does not respond and constant beeping noise when booting up 

b) Diagnose mouse when acting as erratic. 

c) Trouble shoot when the computer has no sound and also no sound is heard from audio media 

9. Write a HTML program using  <p>, <b>, <block quote>, headings: <h1>, ….<h6>, bold, italic and horizontal line tags. 
10. Write a HTML program using Basic tags for a website -  HTML, head, title, body. 
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11. Write a HTML program using tags for lists: Ordered and unordered list 

12. Write a HTML program to create a web page to redirect to goggle, yahoo,facebook, and twitter using tags for 

hyperlinks 

13. Write a HTML program using to create a table of images using Images  and table tags 

14. Write a HTML program using tags for Tables 

15. Write a HTML program using tags for creating Forms and hyperlinks 

16. Write a HTML program using  to Creating a website to display the information about your college 

17. Write a HTML program using to create a website for a product company to display their product and price. 

 

 

Section - II 

 
 Record  : 5 Marks 
 

Viva   : 5 Marks 
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